
GOOGLE DISPLAY 
 
 
We first introduced the Google Display Network (GDN) in Chapter 1 when we outlined the 
Google Network. AdWords provides the ability to advertise on the Display Network, but ads on 
this network reach a different audience and the network's inner workings are very different from 
those of the Search Network. Because of these considerations, we have focused on the Search 
Network up to this point. This chapter covers the Display Network. 

Understanding the Display Network 

The Google Display Network is comprised of over a million content sites[1] – blogs, news sites, 
video, etc. The essential difference between the Search Network and the Display Network is that 
users on the Display Network aren't actively searching for your products. The Display Network 
offers a larger spectrum of ad formats including text, image, rich media, and video ads. Because 
Google has recently been putting more resources into this ad channel, there are a number of 
new targeting options and features. 

When managed correctly, Display Network campaigns allow you to reach a much larger 
audience. They give you the ability to reach people much earlier in the sales process, those who 
aren't yet in the sales funnel. Combining this with campaigns that target visitors later in the sales 
cycle makes for a more powerful marketing effort. 

Unlike Search Network campaigns, which are based entirely on keywords and search engine 
results, the Display Network campaign has several options for targeting your audience. Table 8-1 
outlines the targeting options covered in this chapter. These options can be used separately or 
combined for more precise targeting. 

Table 8-1: Options Available in the Display Network  
Open table as spreadsheet 

Targeting 
Technique 

Targeting 
Method 

How it Works 

Remarketing Audiences Visitors to your site are tagged with a cookie and 
shown your ads as they browse the Display 
Network. Site content is irrelevant. 

Contextual 
targeting 

Keywords Ads are matched to the content of Display Network 
sites based on keyword themes. 

Managed 
placements 

Hand-picked 
sites 

Ads are shown on sites that you manually select. 

Topics Select topics 
from a list 

Ads are shown on sites that contain content that 
matches topics you select. 

Interest 
categories 

Past browsing 
behavior 

Ads are shown to visitors based their past browsing 
interests. Site content is irrelevant. 

Display 
Campaign 
Optimizer 

Target CPA Placements and bids are automatically optimized 
based on historical data to maximize for 
conversions. 

When creating campaigns on the Display Network, it's essential to separate these campaigns 
from campaigns on the Search Network. This allows you to organize your accounts and manage 
settings separately—and to track results better. As shown in Figure 8-1, when creating a new 
display campaign you can start by selecting the default setting for the "Display Network only (text 
ads)", "Display Network only (display ad builder)", or "Display Network only (remarketing)". 
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Figure 8-1: Creating a display-only campaign  

The other option is selecting Default and then changing the network settings, as shown in Figure 
8-2. 
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Figure 8-2: Network campaign settings  

As mentioned, Google is continuing to expand the range of targeting options on the Display 
Network. Take advantage of the various targeting methods available and stay on top of news 
from Google regarding the latest updates. In addition to creating separate campaigns for the 
Display Network, each targeting method should have a separate campaign. 

 [1]Inside AdWords Blog, "Introducing the Display 
Network,"http://adwords.blogspot.com/2010/06/introducing-google-
display-network.html  

 Targeting Your Audience 

 As the set of available targeting options increases, so does the potential audience. Let's 

start with what's generally the most successful: remarketing. 

 Remarketing 

 Remarketing allows you to target visitors that previously visited your website. As visitors 

browse your site's pages, Google tags them with a cookie. Later, as they browse other sites 

on the Display Network, Google presents your ads. Of the various targeting methods, 

remarketing tends to have the lowest cost-per-conversion and highest conversion rate. This 

is largely because you're targeting a well-qualified audience. However, the number of 

visitors to your site limits the reach of remarketing campaigns. In a sense, it's the low 

hanging fruit of the Display Network and results are closest to what you would see on the 

Search Network. If you're just dipping your toe in the Display Network pool, remarketing is a 

good place to start.  
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 The How-To 

 Remarketing campaigns are organized using lists. In this context, a list is a subset of 

visitors to your site that you'd like to target. For example, a list could be visitors that 

abandoned their shopping cart or visitors that viewed a particular product page. Google 

generates a snippet of code for each list. These snippets are then placed on the 

corresponding page or pages of the site you're tracking for that list. This allows Google to 

assign a cookie value to each visitor to these pages. Google adds the cookie IDs to 

remarketing lists maintained within the AdWords system. Google claims that, on average, it 

can reach 84% of the visitors on a typical list[2]. 

 The first step in setting up a remarketing effort is to create your list. To start a list, use 

the tree navigation frame on the left in the AdWords interface, as shown in Figure 8-3. Click 

Shared library ➤ Audiences. 

  
Figure 8-3: Accessing Audiences via the tree navigation  

 Once on the Audiences page, go to New audience ➤ Remarketing list (Figure 8-4). 

  
Figure 8-4: Starting a new audience  

 The next step is to define your audience (Figure 8-5).  
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Figure 8-5: Creating a new remarketing list  

 Name your remarketing list and set the list membership duration. This is the amount of 

time a user's cookie stays on the list; the default setting is 30 days. If the user comes back to 

your site, AdWords resets the cookie for another membership duration period. Aligning your 

membership duration with the length of your sales cycle helps to reach potential customers 

in the consideration phase. The maximum membership duration is 540 days. Click the Save 

button and your new remarketing list will be displayed in the table (Figure 8-6). Notice that 

there are no users in the list. This number will grow once the tag is on your page or pages 

and effectively tagging users. Your remarketing ads will start displaying when this number 

reaches 100. 
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Figure 8-6: Newly created audience  

 Repeat this process for all the audiences you'd like to tag. The custom combination 

feature allows you to track more complex behavior. For example, if you want to track visitors 

that started a shopping cart but didn't convert, you need to create two lists. The first tags 

visitors that created a shopping cart and the second tags visitors that converted. A custom 

list is created with Boolean strings. To complete this example, take the list of visitors that 

created a shopping cart and exclude visitors that converted. The segment left is visitors that 

didn't convert. 

 To obtain your tagging code snippet, click the name of your list and the generated code 

will be displayed in new window. Copy and paste this code into the HTML for the web page 

before the closing </body> tag near the top of the page you'd like to track. For further 

information on installing code and for help with complex web sites, follow the information 

provided via the Insertion Tips.  

 The next step is to create a campaign and associate the campaign with your newly 

created audience. Obviously, the campaign must be set to target the Display Network 

(Figure 8-2). The easiest way to do this is select the default option for Display Network only 

(remarketing) (see Figure 8-1). Choose the bidding method that matches your goals (Figure 

8-7). Because you're reaching a well-qualified audience, you should bid higher than other 

forms of targeting on the Display Network. 

 Larger View 

  
  

Figure 8-7: Bidding options  

 Next, create your first ad group. Because ads are associated with ad groups, name your 

ad groups to match the offer, theme, or the products represented by your ads, such as "Free 

Shipping" or "Ross Reels." You will be prompted to associate your previously created 

audiences with your ad group (Figure 8-8). You will also have the option of adding Topics, 

Keywords or Placements to further specify your audience. Click on Save and Continue. 
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Figure 8-8: Associating an audience with an Ad Group  

 Lastly, you will be prompted to create you ads. You can create text ads, image ads, video 

ads or use the Display ad builder. Alternatively, you can skip ad creation and create your ads 

later.  

 Here are some ideas for creating remarketing lists: 

 Everyone who visits your site (highest volume but less information to base your ads on). 

 Visitors that don't convert. 

 Visitors that started a shopping cart and then abandoned it. Use remarketing to offer an 

incentive to return and complete the sale. 

 Customers (cross-sell, up-sell, or promote related products). 

 Sign-ups—these are well-qualified visitors, as they have already shown interest in your 

brand and offerings. 

 Those who have shown interest in certain products. You have the benefit of knowing 

what products they're interested in, allowing you to customize your creative for each 

product. 

 Use remarketing as an opportunity to advertise promotions. Turn on new campaigns to 

coincide with specials or new deals. Build lists of visitors and treat these lists like you would 

an e-mail marketing list. As with most components in paid advertising, test, test, test. Try 

various combinations to find your niche. 

 Before starting a complex retargeting campaign, it's good to consider the volume of 

visitors you will be tagging. Start with a simple campaign, like targeting all past visitors to 

your site. Users are added to a list as soon as they leave your site, which means they can be 

served an ad the next time they reach a site on the Display Network. In many cases, you will 

see the best results shortly after users have left your site. If you're seeing positive results, 

continue to tag visitors until you find it's no longer profitable. 

 Once your ads are running and you have data to review, use this opportunity to take 

greater control of where your ads will show. Check out the data in the Networks tab and 

exclude sites that are bad performers or eliminate categories that don't mesh well with your 

brand. 

 If you are worried about over-exposure, use the Frequency Capping option within the 

advanced setting in the campaign setting to limit the number of times a visitor sees your ad 

in a given period. We discuss this setting in more detail at the end of this chapter. 

 Contextual Targeting 

 With contextual targeting, also called automatic placements, Google uses a contextual 

algorithm to evaluate the keywords in an ad group and make placements based on the 

overall theme of the keyword group. Unlike the Search Network, it's okay to be general with 

your keywords. The algorithm works at the page level, not the site level, to place your ads as 

precisely as possible. The recommended number of keywords is around 20, and you should 

not go over 50 keywords. Keywords should be tightly themed and you can use multiple ad 

groups to reach multiple themes with varying ad content. As with search campaigns, you 



should use negative keywords to further refine your theme. Other than negatives, however, 

match types don't matter.  

 The Contextual Targeting Tool 

 Google provides a Contextual Targeting Tool accessible directly from the AdWords 

interface. To access the tool, go to Adwords ➤ Tools and Analysis ➤ Contextual Targeting 

Tool (Figure 8-9). 

  
Figure 8-9: Accessing the Contextual Targeting Tool  

 To use the tool, enter the keywords for your contextual campaign in the box at the top 

of the page (Figure 8-10). Google generates a list of suggested ad groups, including the 

suggested ad group name, keywords, and suggested bid. You can expand each ad group to 

see additional ad group ideas. 

 Larger View 

  
  

Figure 8-10: The Contextual Targeting Tool  

 To see a list of predicted sites (Figure 8-11), click the symbol within the ad group line. 

The result is like a sneak peek into your future Automatic Placements report. 
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Figure 8-11: Predicted Placements report  

 Select the ad groups that you feel are a good match for your campaigns and edit the 

keywords as needed. From there you can add the ad groups directly to your AdWords 

account or export to the AdWords Editor. The AdWords Editor export feature provides an 

opportunity to view the data in a spreadsheet, make your edits, and then import back into 

the AdWords Editor. Note that the suggested bids are included as well, so be certain to 

change these as needed. 

 Managed Placements 

 With managed placements, you handpick the sites on which you'd like your ads to run. 

Look for sites with the sort of typical visitor profile that you would like to target. 

 Managed placement campaigns don't require keywords, since your ads will only run on 

sites you select. However, you can use keywords with managed placement to better match 

your ads to pages within a selected site. When you use both keywords and selected 

placements, you can tell Google how you'd prefer to match your ads (Figure 8-12).  

 Larger View 

  
  

Figure 8-12: Display Network options  

 If you choose Broad reach, your ads will show when either the keyword or the 

placement is a match. If both are a match, the bid from the placement is used because it's 

more specific. 

 If you choose Specific reach, your ads will only show if your keywords match the theme 

of the placement you selected. Again, the placement bid is used. 

http://viewer.books24x7.com/assetviewer.aspx?bookid=47025&chunkid=155611090&resumebookmarkid=850221d2-8e56-e611-94a7-005056862d7f


 It's often good practice to run both a managed placements campaign and a contextual 

targeting campaign. The contextual targeting campaign allows you to cast a wider net and 

find those sites that are profitable for your business. You can then add these sites to the 

managed placements campaign and exclude them from the contextual campaign. This gives 

you more control over the bids on better performing sites. As an alternative to excluding a 

site, you can add it to managed placements and set the bids lower. 

 The Placement Tool 

 The Placement Tool can be used to find sites and pages across the Display Network that 

are matches for your site. There are two places within AdWords to access the Placement 

Tool. The first is via the Tools and Analysis menu in the main navigation tabs, as shown in 

Figure 8-13. 

  
Figure 8-13: Accessing the Placement Tool from the Tool and Analysis menu  

 The second option is through the Networks tab: look under Display Network ➤ 

Managed placements ➤ show details (Figure 8-14). 

  
Figure 8-14: Accessing the Placement Tool from the Networks tab  

 From here click +Add placements ➤ Try the Placement Tool. Once the tool launches, 

search for placements by entering words or phrases to match your site. You can also start 

your search by entering the URL of your web site. To refine the results, use words or phrases 

from your web site. Clicking Search generates a results table. To filter your results, you can 

select from the options shown in Figure 8-15. 
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Figure 8-15: Advanced filtering option in the Placement Tool  

 Note the options for finding sites based on demographic data (age, gender, education, 

and income). Use these selections (you can use up to three at once) as another means of 

more focused targeting of your audience. 

 In addition to filtering on the criteria shown in Figure 8-15, you can use Categories and 

Placement types to further refine your results. These options are found on the left of the 

screen. Figure 8-16 shows an example results table.  
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Figure 8-16: Placement Tool results  

 To select placements, you can check the box next to placements you'd like to add to 

your ad group and then click +Add placement. The star functionality allows you to create an 

ongoing list of placements that is maintained through new searches (just like the Keyword 

Tool discussed in Chapter 6). AdWords maintains the list of starred placements between 

sessions and shows this list in the bottom right corner of the results table. You can download 

selected results or starred results, or perform a bulk download. 

 Doubleclick Ad Planner 

 Another tool for researching potential placements is the DoubleClick Ad Planner, which 

is a research and media planning tool that provides insights into demographic profiles of 

web sites. You can use this data to determine what web sites your potential audience is 

likely to visit. DoubleClick data is available directly in the Placement Tool. To see data on a 

site, simply click the magnifying glass next to the web site you'd like to research. You should 

see the following data: 

 Traffic statistics (Take a close look at Unique Visitors, Page Views, and Total Views.) 

 Daily unique visitors 

 Age 

 Education 

 Gender 

 Household income 

 Sites also visited (Hint: This is a great place to look for other sites to target.) 

 Audience interest 

 In addition to accessing the DoubleClick data in the Placement Tool, you can access the 

tool externally at www.google.com/adplanner. As you do your research in DoubleClick, your 
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results are saved as a media plan, which stores the lists of web sites where you'd like to 

advertise and aggregates results for all the web sites in the media plan. For more 

information on DoubleClick Ad Planner, access the help center from inside the tool.  

 Topic Targeting 

 With topic targeting, AdWords matches your ads to sites within the Display Network 

based on the topic categories you select. Usually this method of targeting reaches the 

largest audience, but it also tends to convert at a lower rate. There's no need to select 

placements or keywords, although you can use keywords and placements to refine where 

your ads will show. The list of possible topics consists of 1,750 topics and sub-topics. Target 

topics closely related to your business. It's best to start with low bids and monitor results to 

see that the placements you're seeing make sense. Although the list of topics is large, the 

categories are still broad. 

 The How-To 

 To start a campaign with topic targeting, create a new campaign set to target the Display 

Network. To configure your topics, you need to access the Topics tab. By default, this tab is 

not displayed, but you can add it by clicking on the pull-down at the end of the tabs and then 

clicking on the box next to Topics (Figure 8-17). 
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Figure 8-17: Adding a Topics tab  

 Click + Add topics and the list of available topics will appear (Figure 8-18). Expand the 

topics indicated with a + to see additional sub-topics.  
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Figure 8-18: Topic options  

 Selecting a top-level topic includes all the sub-topics by default or you can handpick the 

sub-topics. However, selecting all the sub-topics isn't the same as selecting the top-level 

topic, since there can be sites that fall under the higher-level topic that aren't included in 

any of the sub-topics. 

 In addition to adding topics, you can also exclude topics. For example, if you select Food 

& Drink as a topic, you can exclude Restaurants. This works in a fashion similar to negative 

keywords. The Exclusions option is located at the bottom of the page within the Topics tab 

(Figure 8-19). Exclusions can be set at the campaign or the ad group level.  
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Figure 8-19: Exclusion options  

 As mentioned at the start of this section, topic targeting alone reaches a broad 

audience. Consider using topic targeting in conjunction with other forms of targeting to 

better hone in on your audience. 
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 Placements + Topics: Find your niche within large sites. For example, you could target 

content related to travel within the New York Times web site. Additionally, you can exclude 

topics you know to be irrelevant to your business. 

 Audiences (Remarketing or Placement selections based on demographics) + Topics: Limit 

the views of your ad (think reducing ad fatigue) by only showing your ads when previous 

visitors to your site are on sites with related topics. 

 Keywords + Topics: Refine the reach of your keywords by adding topics to contextually 

targeted campaigns. Using keywords in conjunction with topics takes away the emphasis 

from particular keywords. Instead, Google treats the keywords as a theme. Do some of your 

keywords have multiple meanings? Highlight the correct meaning of your keywords by only 

displaying ads on sites with related topics. 

 When using the previously mentioned combinations, make sure that your network 

settings are set to "Specific reach: Show ads only on pages that match all my targeting 

options" (see Figure 8-12.)  

 Interest Categories (Behavioral) 

 Another option for targeting involves the use of interest categories. This is also known as 

behavioral marketing. Google assigns interest categories to users based on the sites they 

visit as they browse the Display Network. You can then advertise to users with interests that 

match your business. Say, for example, that your business sells kitchenware. In a contextual 

campaign, your ads would shows on sites with content focusing on cooking. By setting up 

interest categories, your ad would show after the visitor has left the cooking-related sites 

and started browsing a new topic. Interest categories let you reach a cooking enthusiast on a 

wider range of sites. The sites your ads run on may or may not match your business, but 

your ads will follow users with the selected interests. This is in contrast to topic targeting, 

where the site displaying your ad matches your business. 

 Users can see the data that Google has compiled about them at 

www.google.com/ads/preferences. It's interesting to check out what Google has for your 

interest profile. We found our profiles to be surprisingly accurate. While you're checking out 

what Google thinks about your interests, you can also opt out of interest-based targeting, 

manually remove categories not of interest, or add categories you feel should be included. 

 The How-To 

 To start a campaign based on user interests, create a new campaign strictly for this 

purpose. Create an ad group and associated ads. Next, select interests by navigating to the 

Audiences tab. (Again, the Audiences tab isn't shown by default.) Click +Add audiences. You 

will see the list of interest categories as well as the estimated number of global users in each 

category, as shown in Figure 8-20. 
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Figure 8-20: Targeting based on user interests  

 Click the + plus sign to expand a category to show its sub-categories. When getting 

started, it's best to target interest groups closely related to your products. Use the data 

generated by this first campaign to make decisions on additional sub-categories and/or 

additional interest categories. Consider using keywords in conjunction with interest 

categories to specialize your traffic further. You can easily combine interest categories with 

remarketing lists by using custom combinations. For example, you could combine a 

remarketing list that only includes visitors to your site that did not purchase with an interest 

category. This allows you to save your interest-based impressions for visitors that have not 

already made a purchase. Use the Custom combinations tab (upper right of Figure 8-20) to 

combine both interest categories and remarketing lists. 

 The Display Conversion Optimizer 

 The Display Conversion Optimizer (DCO) uses historical data to adjust bids to meet a 

target CPA. You provide the CPA goal and your daily budget, and the DCO starts by targeting 

sites that are contextually relevant based on signals from your web site. Use results from the 

first round of targeting to find additional sites to target, focusing on finding more 

conversions by automatically optimizing targeting and bidding options. As of this writing, the 

DCO is only available to a select group of advertisers. If you have a campaign that's eligible, 

you will see a link for "Automatic campaign optimization" within the Settings tab. Current 

requirements include 15 conversions per month with target CPA bidding enabled. 

 Targeting Options Summary 

 With all of the available options and combinations we've discussed up to now, we can 

certainly understand if your head is spinning. Years ago, setting up a Display Network 

campaign was an arcane art: click Save and cross your fingers. With the array of new 

options, many AdWords advertisers have a renewed interest in the Display Network. Taking 

the time to understand the various options on the Display Network will greatly increase your 

ability to reach customers while they browse the web. Refer back to Table 8-1 as you need 

to for a summary of the various marketing approaches available on the Display Network. 

 [2]Google Inside AdWords Blog, "Year in review: Remarketing delivers better ads, better 

performance," http://adwords.blogspot.com/2011/05/year-in-review-remarketing-

delivers.html  
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Bidding Options 

We covered bidding options in Chapter 2, but let's review them here. The bidding options on the 
Display Network include 

▪ Cost-per-click (CPC): This is the best choice when controlling spending is a high priority, as you 
have more control over what you're spending per visit. CPC bidding is also helpful when you 
want to evaluate your cost per conversion at the ad group or placement level. Other 
circumstances for using CPC bidding are when running text ads or when your ads first start 
appearing on the Display Network. CPC bids can be set at the keyword, placement, or ad group 
level. You can also use automatic CPC bidding, which allows you to set a daily budget; Google 
sets the bid amount in an attempt to get to the most bids possible.  

▪ Cost-per-mille (CPM): This is the better choice when looking for exposure and to increase brand 
awareness. You are charged each time your ad is displayed, regardless of whether the user 
clicks it. With CPM bidding, you set a maximum CPM bid. Note that CPC and CPM ads will 
compete with each other in the same auction. In this case, AdWords calculates an effective CPM 
(eCPM) for CPC ads. The bid, the click-through rate, and other ranking factors are considered 
across 1,000 impressions.[3]  

▪ Cost-per-acquisition (CPA): CPA bidding is used in conjunction with the Conversion Optimizer. 
You set the amount you're willing to spend per conversion and Google manages the bid amount. 

▪ Enhanced CPC: Enhanced CPC adjusts the max CPC based on the likelihood that your ad will 
convert in the current auction. In contrast to the Conversion Optimizer, Enhanced CPC bidding 
doesn't have conversion volume requirements and allows you to set maximum CPC versus 
maximum CPA. However, because Google isn't basing results on CPA, but only on historical 
conversion data, it's possible that you will see an increase in CPA. Google runs a split test with 
two groups: a control group (not managed by Enhanced CPC) and an experiment group. If 
positive results are seen, the size of the experiment group is increased.[4]. Overall, Enhanced 
CPC seems to work best on campaigns with a strong and consistent conversion history. 

[3]Adwords Help, "How do CPC and CPM ads compete with each other?," 
http://support.google.com/adwords/bin/answer.py?hl=en&answer=113233  

[4]"Google AdWords Enhanced CPC vs. Conversion Optimizer" – Search Engine Watch, August 
20, 2010: http://searchenginewatch.com/article/2064650/Google-AdWords-
Enhanced-CPC-vs.-Conversion-Optimizer 

Display Ad Creative 

Because most display campaigns target a different audience from search campaigns (i.e., users 
not actively searching for your products), you should design your ads with this in mind. Users on 
the Display Network aren't necessarily part of the buying funnel, with the exception of those 
included in some remarketing campaigns. When targeting a passive audience, you need a 
stronger call to action. Give users a reason to act quickly and take action sooner. Without a 
compelling reason to act quickly, they're likely to continue browsing without taking action. Image 
ads have the advantage of including buttons that clearly state a call to action. Research the sites 
where your ads are showing, see what the competition is doing, and make an effort to stand out. 

Carefully consider the targeting method when determining the focus of your ads. Contextual 
targeting, managed placements, and topics campaigns are matching on keywords or placements 
that match your business and products. If you've selected the right placements, you will be able 
to make a connection between the content of the display site and your business and products. 
The more relevant your ad to the content of a site, the more likely you will see higher click-
through rates. With interest-based targeting, you want to make the connection between your 
products/business and the interest category. Remarketing campaigns give you the advantage of 
understanding your audience. For example, if you're targeting an audience that viewed a 
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particular product, use that information to make your ad relevant. The lure of a special offer may 
persuade users who've abandoned a shopping cart to return to your site. When remarketing, use 
ads that match the look and feel of your web site to increase a viewer's recall of your site. To 
reduce ad fatigue, be certain to rotate your ads. 

A good rule of thumb is to create separate ad groups for image ads and text ads. The 
performance of these ad groups will usually differ, enabling you to make better decisions on 
placements and bids. 

Ad Types 

Advertisers on the Display Network can choose from a variety of ad options, including text, 
image, rich media, and video. We recommend trying a variety of ad types to see what works best 
for your message. The following list provides a quick overview of the primary ad categories that 
appear on the Display Network: 

▪ Text ads: Text ads on the Display Network follow a similar ad format to text ads on the Search 
Network, discussed in Chapter 7. Figure 8-21 shows an example of two text ads (designated by 
the arrows on the right). Text ads can also appear in videos and feeds within the Display Network 
(Figure 8-22). In general, using text ads on the Display Network isn't recommended, since they're 
not nearly as eye-catching as other ad formats in this context. However, around 25% of the sites 
within the GDN only accept text ads, so you can't always avoid this option.  

▪ Image ads: These ads consist of an image and text, can be static or animated, and may include 
basic interactivity. Image ads must also meet Google's ad standards. You can create images to 
meet the ad specifications or you can create ads via the Display Ad Builder, as we will discuss 
shortly. In most cases, image ads see higher click-through rates than text ads, but overall click-
through rate on the Display Network is lower than on the Search Network. Figure 8-23 shows an 
example image ad and Table 8-2 shows the sizes and specs for image ads. In general, 728 x 90 
and 300 x 250 pixels are the most common image ad sizes. If you are looking to start small, 
creating ads for these sizes would reach the largest audience. 

▪ Expandable ads: This category includes flash-animated ads that are interactive and expand 
when clicked. 

▪ Product Ads: As with the Search Network, you can use a data feed from your Merchant Center 
to generate product-specific ads on the Display Network. The Contextual Dynamic Creative 
(CDC) Template (currently in beta), which is part of the Display Ad Builder, is a tool for creating 
ads for products from a Google Merchant Center feed. Prior to the creation of this tool, each 
product being advertised required a separate ad. If you want to advertise products from your 
Merchant Center on the Display Network, chances are good that this tool will become more 
widely available. 
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Figure 8-21: Sample text ads on the Display Network  
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Figure 8-22: Text ad embedded in video  
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Figure 8-23: Sample image ad on the Display Network  

Table 8-2: Techical Requirements for Image Ads (Sizes are in Pixels)  

Open table as spreadsheet 

Formats .gif, animated .gif, .jpg, .swf, .png, and Flash 

Image Ad sizes (IAB standards) Banner: 468 x 60S 
quare: 250 x 250 
Small square: 200 x 200 
Leaderboard: 728 x 09 
Medium rectangle: 300 x 250 
Large rectangle: 336 x 280 
Skyscaper: 120 x 600 
Wide skyscraper: 160x 600 

Expandable Ad sizes 120 x 600 
468 x 60 
728 x 90 
300 x 250 
160 x 600 
336 x 280 

File Size No larger than 50k  

Note  
Promote your site with Google +1 by opting to include the +1 button on your Display 

ads. Access this feature from Campaign settings ➤ Advanced settings ➤ Social 

settings. 

AdWords for Video 

As of this writing, AdWords for video is still in beta after Google completely overhauled how video 
ad campaigns are created and managed within AdWords. Under this new approach, you upload 
your videos to your YouTube channel and then link your AdWords account to your YouTube 
account. Overall, the new process is simpler: once your videos are uploaded to YouTube, it only 
takes a few quick steps to integrate those videos into a display ad. Ads can contain both video 
and text. You can choose to target your ads strictly to YouTube or both YouTube and the Display 
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Network. If you choose the latter, you can select from the various targeting options for the 
Display Network just discussed. 

Bids are set through a cost-per-view (CPV) model. The new ad formats are called "TrueView." 
This is meant to highlight that the advertisers only pay when the ad is viewed; charges are not 
accrued from impressions. The definition of a "view" varies depending on the type of ad. Ad 
types are listed below: 

▪ TrueView in-stream ads: Ads play within YouTube videos or videos on the Display Network. 
Your ad can appear before, in the middle of, or after the video. Viewers have the option to skip 
the ad after 5 seconds of play. You are charged if the viewer watches the entire ad or for 30 
seconds, whichever occurs first. 

▪ TrueView in-search ads (formerly YouTube Promoted Videos): Ads are displayed above the 
search results on YouTube. This format allows you to promote YouTube videos. Google selects 
ads to display by matching the search query to the content of the video you are promoting in the 
ad. You are charged when your ad is watched. 

▪ TrueView in-slate ads: These ads are run in conjunction with "longform" videos on YouTube or 
the Display Network, which are videos longer than 10 minutes. Viewers have the option of 
selecting one of three ads to watch before viewing the video or of watching commercial breaks 
during the play of the video. If your ad is selected, you are charged and your video is presented 
to the viewer. 

▪ TrueView in-display ads (formerly Click to Play): Videos are promoted across the Display 
Network or on YouTube as display ad units. These ads are what you would typically think of if 
you wanted to use video as your format on the Display Network. You are charged when a users 
chooses to watch your video. 

The How-To 

To start a video campaign, go to Campaigns ➤ +New campaign ➤ Online video, as shown in 

Figure 8-24. 
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Figure 8-24: Starting a new video campaign  

The next screen walks you through the selection of your campaign settings. The process and the 
options are similar to selecting settings for typical campaigns. First, name your campaign, set a 
budget, and select your locations and languages (Figure 8-25).  
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Figure 8-25: Campaign settings in a new video campaign  

Next, to create your ad, click the Select video button, as shown in Figure 8-26. 
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Figure 8-26: Selecting the video  

The resulting pop-up prompts you to link your YouTube channel to your campaign and the videos 
in your channel will be displayed (Figure 8-27). You can also select videos by entering the 
YouTube URL of the video (top left in the figure).  
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Figure 8-27: Selecting a video from your YouTube channel  

After selecting your video, create the actual ad (Figure 8-28).  
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Figure 8-28: Creating a video ad  

Choose the format and network. The Automatic option shows your ad on all available networks. 
Selecting "Let me choose" lets you mix and match the formats and networks of interest (the 
various formats were outlined at the start of this section). Figure 8-29 shows the options for 
networks and the corresponding formats.  
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Figure 8-29: Selecting networks and ad formats  

The following list gives a brief description for the network options: 

▪ YouTube Videos: In-display, in-stream, and/or in-slate videos. Videos on YouTube Watch and 
channel pages. (A YouTube Watch page is simply the page where the video is viewed.) 

▪ Google Display Network: In-display, in-stream, and/or in-slate videos. Ads appear on the GDN 
or YouTube. 

▪ YouTube Search: In-search videos. YouTube search results and Google video search. 

If you're setting up your first video campaign, we recommend selecting automatic (Figure 8-28, 
under "Ad formats & networks"). The AdWords for video interface provides a wealth of data to 
help you further refine your sections as your campaign matures. 
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The Advanced ad attributes contain some additional options, depending on your selected ad 
formats (Figure 8-30).  
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Figure 8-30: Setting advanced ad attributes  

In-search and in-display ads can take viewers to your YouTube Watch page or your YouTube 
channel. Click "Save and continue." 

The next screen walks you through your targeting options. Targeting is configured through the 
use of targeting groups. Set your bids by targeting group. The maximum CPV entered is similar 
to your ad group default bid. You can set one bid for all ad formats, or you can set a separate bid 
for each ad format (Figure 8-31). 
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Figure 8-31: Setting bids for video campaigns  

If you leave the "Custom bid per format" box unchecked, move the Views/Engagement slider-bar 
to set the bidding to emphasize views over engagement or vice versa. This will adjust the bid 
amounts among the four formats to emphasize or de-emphasize views vs. engagement 
according to your setting.  

Next, select your targeting options for this target group. Here are the options for targeting: 

▪ YouTube search: This option is analogous to running text ads on Google.com. You select 
keywords that match the theme of your video. Visitors searching in YouTube will see your ad 
above the YouTube results when their search matches your keywords. 

▪ YouTube Videos + Google Display Network: Figure 8-32 shows the list of targeting options. 
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Figure 8-32: Targeting options for video campaigns  

As you can see, these are the same targeting methods we just reviewed. 
▪ Topics: As with regular display campaigns, topic targeting allows you to choose a group of 

placements based on the topic of these sites. 
▪ Display Network keywords: Much like contextual targeting in display campaigns, your video is 

matched to sites based on keyword themes. 
▪ Demographics: Do you want to target a specific gender and/or age group? Select from the 

options shown in Figure 8-33.  
▪ Topics: As with regular display campaigns, topic targeting allows you to choose a group of 

placements based on the topic of these sites. 
▪ Display Network keywords: Much like contextual targeting in display campaigns, your video is 

matched to sites based on keyword themes. 
▪ Demographics: Do you want to target a specific gender and/or age group? Select from the 

options shown in Figure 8-33. 
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Figure 8-33: Demographic options for targeting video campaigns  

For targeting suggestions, Google provides a Targeting Suggestion Tool (Figure 8-34). 
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Figure 8-34: Targeting suggestion tool  

You can mix and match targeting options to create a variety of targeting groups. 

One of the benefits of the AdWords for video interface is the amount of data available. You can 
see where your videos were watched and for how long. For example, you can see if your video 
was played to 25%, 50%, 75%, or 100%. In addition, you can easily segment data to see results 
by network, format, ad, and campaign. Data is available at the ad, video, and target level. 

Although this ad format is still new, we see a lot of promise in AdWords for video. YouTube is 
currently the number two search engine (after Google.com) and AdWords for video opens up a 
ton of new ad inventory. Use well-crafted video ads to engage with your potential customers on a 
new level. Keep in mind that with in-stream ads, the first five seconds will determine whether a 
user continues to watch. This is also five seconds to get your brand in front of users who aren't 
going to take the time to watch the entire video. Make those seconds count! 

Display Ad Builder 

To help advertisers quickly create image, rich media, and interactive ads, the AdWords interface 
includes the Display Ad Builder. To launch the Display Ad Builder, click the Ads tab within the ad 
group that you'd like to create an ad for, then +New Ad, and select the "Display ad builder" 
option. 

Once the tool launches, you will see a variety of ad templates. The default sample ads are the 
featured ads, which are ads recently added, high performing ads, frequently used ads, or ads 
relevant to upcoming holidays. As you browse through these, you can star ads to save them for 
consideration. There are multiple ways to search the templates. You can select the Show all 
option and then use the Sort by function to select either the newest, most popular, or highest 
click-through ads. You can also sort by theme, as shown in Figure 8-35. 
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Figure 8-35: Display Ad Builder themed templates  

Each ad template has a version for each of the standard display ad sizes. To see what a 
particular ad looks like in each size, hover over the ad and click the link for Preview sizes. A pop-
up will display the variously sized layouts (Figure 8-36).  
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Figure 8-36: Preview of various ad sizes with the Display Ad Builder  

Once you've selected a template you want to use, click that format and the tool will take you to a 
screen that walks you through building your ad. The tool uses the information you enter to build 
your ad. The prompts will vary according to the ad's layout. As you build the components of the 
ad, the tool displays a preview on the right of the screen. Once you've built your ad, click "See all 
sizes" to review the ad in the various sizes. Click the checkboxes next to the desired ad sizes 
(Figure 8-37).  
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Figure 8-37: Selecting ad sizes in the Display Ad Builder  

Click Next. You get one more chance to review the various ad sizes. All sizes are selected by 
default. If you aren't interested in using a particular ad size, uncheck the box next to that ad. 
Click the Save ad button and the tool will list your newly created ads in the table within the Ads 
tab. 

The Display Ad Builder is a good way to quickly generate image ads for use on the Display 
Network. Use this tool to test various ads and messaging and enhance the more successful ads 
with professional help from a graphic designer or ad agency. 
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Creating Video Ads 

You can also use the Display Ad Builder to create a video ad from an existing video. To get 

started, go to Display ad builder ➤ Media and channels ➤ Video, as shown in Figure 8-38. 

 
Figure 8-38: Creating video ads  

Figure 8-39 shows the various options for video ads.  

Larger View 

 

 

Figure 8-39: Video ad creation options  

Select the type of video ad you want to create and follow the prompts to complete the details of 
your ad. You can use a previously used video, a YouTube video, or create an ad with SpotMixer 
(www.spotmixer.com). The latter is an online service Google has partnered with to enable 

advertisers to create their own videos and TV commercials (Figure 8-40).  
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Figure 8-40: Setting up a video ad on SpotMixer  

Content Ads Diagnostic Tool 

To see if your ads are appearing on the Display Network, you can use the Content Ads 
Diagnostic Tool.[5]. This tool provides information on your ads' visibility on a URL basis. Much like 
the Ads Diagnosis Tool for the search ads, you see the data for a URL by hovering over the 
speech bubble next to the URL. You can see if your ads are running on that site and if not, why 
not. There are two places to access this tool in AdWords. 

The first way to access the tool is on the Adwords ➤ Campaigns ➤ Networks tab. Click on Show 

details for Managed placements under the Display Network heading. Click "Show details" and 
look at the status column. (Be sure you have clicked All online campaigns in the left navigation 
frame.) The left column shows the domain for each placement. Hovering your cursor over the 
speech bubble in the Status column for a placement will tell you the status of the placement, and 
whether your ads are running for that placement. 

The second location is via the Topics tab, which shows the status for URLs that are part of a 
Topics campaign. (If the Topics tab is not showing under the Campaigns section, see "The How 
To" under the Topic Targeting section earlier in this chapter.) 

[5]"Evaluating ad performance on the Display Network" – Adwords Help: 
http://support.google.com/adwords/bin/answer.py?hl=en&answer=2404178  

Success on the Display Network 

Before starting a campaign on the Display Network, as with all your marketing campaigns, you 
should think about what you want to accomplish with your Display Network campaign. The 
Display Network is a great place to go when looking to expand the number of people entering the 
sales funnel and to increase the reach of your brand. However, it does come at an additional 
cost, so make sure it makes sense in terms of the marketing ROI for your business. 

When judging success, remember that the Display Network behaves much differently than the 
Search Network. Success on the Display Network requires careful testing and optimization. 
There are several places to define your goals on the Display Network. Here are a few pointers for 
measuring success on the Display Network. 
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▪ Use multi-channel tracking: This is a new feature in Google Analytics that gives you the ability 
to track visitors at various touch points along the conversion path. Display advertising often 
increases conversions. We take a closer look at multi-channel tracking when we discuss Google 
Analytics in Chapter 11. 

▪ Track conversions: The GDN increases your number of ad impressions, so expect to see a 
decreased CTR and a lower conversion rate than on the Search Network. Note that this is by no 
means a rationale for letting your CPA goals slip. 

▪ Decide on a bidding model: When bidding on a CPC model, use descriptive ads to help weed 
out unqualified traffic. 

▪ Increase brand awareness: One way of understanding how to increase brand awareness is by 
tracking your branded searches in Google Analytics. This is covered in Chapter 11. 

 

Tracking and Optimizing on the Display Network 

As Google continues to expand the Display Network, it also continues to create tools to help you 
understand the performance of your campaigns. This section talks about some tools that can 
help you evaluate and improve your results on the Display Network. 

The Placements Report 

The Placements Report tells you how your ads are performing on sites across the network. With 
all the improvements in reporting that have become available over the years, it's interesting to 
think that there was a time when even this data was not available. To access the Placements 
Reports, go to the Networks tab. The data table displays information for both the Search and 
Display networks. To see data for either your managed or automatic placements, click Show 
details. Figure 8-41 shows a sample line item from the report.  
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Figure 8-41: A view of the Placements Report  

As you can see from Figure 8-41, the Placements Report provides data on clicks, impressions, 
click-through rate, cost per click, cost, and conversions at the site level. To see the exact URLs, 
click the See URL list drop-down. Much like the Search Query Report, the URL List Report 
provides greater granularity into the exact URL query. Look for well-performing sites that can be 
added to a managed placement campaign; then optimize your bids on these well-performing 
sites. (However, keep an eye on sites you've added to your managed placements. In some 

http://viewer.books24x7.com/assetviewer.aspx?bkid=47025&destid=954#954
http://viewer.books24x7.com/assetviewer.aspx?bkid=47025&destid=954#954
http://viewer.books24x7.com/assetviewer.aspx?bookid=47025&chunkid=984052112&resumebookmarkid=850221d2-8e56-e611-94a7-005056862d7f
http://viewer.books24x7.com/assetviewer.aspx?bookid=47025&chunkid=984052112&resumebookmarkid=850221d2-8e56-e611-94a7-005056862d7f


cases, CPA can increase with managed placements.) In addition, be certain to exclude sites that 
aren't performing well. To exclude a site, select the placement and then click the Exclude 
placements button. Only exclude pages within a placement by viewing the URL list and 
performing the same exclusion process. Also, look for themes in placements to see where you 
might want to break out your keywords more. 

Another place to see placements data is on the Dimensions tab by selecting "View: Automatic 
placements" (Figure 8-42).  

 
Figure 8-42: Viewing automatic placements from the Dimensions tab  

From here, you can see the exact URLs at the ad group or the campaign level. The Dimensions 
Report allows you to customize the columns. 

Placements Data in Google Analytics 

Another opportunity for viewing placements data is in Google Analytics. To access the 

Placements Report in GA, in the left navigation frame go to Advertising ➤ AdWords ➤ 

Placements (Figure 8-43). 
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Figure 8-43: Selecting the Placements Report in Google Analytics  

One advantage of viewing data in Google Analytics is the insight it provides into on-site data and 
user engagement with your site. What did visitors do once they arrived? Did they stay and check 
things out, or did they take one look at your site and run the other way? Google Analytics 
provides data to answer these kinds of questions at both the domain and URL level (Figure 8-
44). 
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Figure 8-44: Placement domain and URL data is available in Google Analytics.  

Another option is to use placement URLs and placement domains as secondary dimensions in a 
variety of other reports, such as the Day Parts Report (Figure 8-45) 
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Figure 8-45: Day Parts Report in Google Analytics  

You can set placement domain and placement URL as secondary dimensions in the following 
reports: Keyword, Matched Search Query, Day Parts, Destination URLs, and Keyword Positions. 
We will talk more about the reports available in Google Analytics in Chapter 11.  

Excluding Placements by Site or Category 

There are often reasons to exclude placements on certain sites or in certain categories of sites. 
You may find that some sites (domains) don't perform well in terms of the CTR for you display 
ads. Certain categories of sites may not work well for your brand. You can exclude specific sites 
or categories either at the ad group level or at the campaign level. You can also create exclusion 
lists that can be shared across multiple ad groups or campaigns. 

To navigate to the area where you can define and manage exclusions and exclusion lists, go to 

Adwords ➤ Campaigns ➤ Networks. Click on All online campaigns in the left navigation frame if 

you want to define exclusions across all or a number of campaigns. Expand the Exclusions link in 
the lower left of the page by clicking on the + sign (Figure 8-46). 
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Figure 8-46: Opening exclusion lists in the Networks tab  

This will expand the exclusion lists for both ad groups and campaigns. Figure 8-47 shows the top 
few exclusions for ad groups and campaigns. Click on the Add exclusions drop-down for the 
Campaign level list, and select Exclude category. 
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Figure 8-47: Selecting the Exclude Category in the Add exclusions drop-down  

This will bring up the Category exclusion dialogue box (Figure 8-47). Click on the Choose button 
to select a campaign. 
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Figure 8-48: Selecting a campaign for setting up exclusions  

Choose which campaign you want to manage, and a list of exclusion categories will be 
presented. Figure 8-49 shows the top few entries in this list. As of this writing, the full list included 
23 categories. The list includes a range of data for the campaign in each category to help you 
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Figure 8-49: Selecting exclusion categories for a campaign  

Use this data—paying close attention to the two cost-per-conversion columns—to help you 
decide which categories are not cost-effective, or are otherwise not meeting your goals. To 
exclude a category, simply click the checkbox to the left of the Category name, as shown in the 
figure. Once you've selected the categories to exclude, click the Save button at the bottom of the 
list. 

This is also your opportunity to see how your ads are performing on parked domains and error 
pages. If you are paying on a CPM model, use the category exclusions facility to exclude your 
ads from showing below the fold.  
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Unseen Impression Filter 

This one is more of an FYI, rather than a report that you can set up and run. Basically, if your ad 
is displayed below the fold, the likelihood of someone seeing your ad is low. The Unseen 
Impression Filter ensures advertisers aren't charged when Google predicts that a user will not 
scroll to see your ad. In other words, you won't be charged for ads with a "low probability of being 
seen." This feature is set up automatically and requires no action on your part[6]. 

Frequency Capping 

If you're concerned your customers may grow weary of seeing your ads as they browse the web, 
you can use frequency capping to limit the number of ads served to an individual user per day, 
per week, or per month. To turn on this functionality, navigate to Advanced settings under 
Campaign settings (Figure 8-50). Select the campaign you want to set a frequency cap for in the 
left navigation frame. You can apply the setting at the ad, ad group, or campaign level[7]. 
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Figure 8-50: Frequency capping settings  

Relative CTR 

The relative CTR metric compares your CTR to those of other ads running on the same 
placements across the network. To see this metric you can customize the columns at the 
campaign or ad group level of the account. The following equation is used to determine relative 
CTR: 

 

Larger View 

 

Relative CTR = (Your CTR)/(CTR of all Advertisers on the same 

placements) 

 

Relative CTR is an indication of how well your ad content is resonating with your audience on the 
Display Network and it gives you an indication of your quality score. A relative CTR of 1 means 
your CTR is the same as the overall average for the same placements. A relative CTR lower than 
1 tells you that your competitors are outperforming you. This is a good starting point for testing 
alternative ad creatives to see if you can improve your CTR. 

In addition, make sure your placements are relevant. You can also take a closer look at your 
CPA. If you're meeting your CPA goals, look at how you can improve on placements. If you have 
a good CPA but low relative CTR, this is a sign you're on the right placements but may be 
missing some opportunities. 
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[6]"Google Display Network introduces new performance bundle" Google Inside Adwords Blog, 
June 14, 2011. http://adwords.blogspot.com/2011/06/today-innovations-in-
targeting.html  

[7]See the section titled "Setting a frequency cap on impressions for your Display Network ads" 
in"Choose an ad delivery method," Adwords Help Center - 
http://support.google.com/adwords/bin/answer.py?hl=en&answer=2404248&fr

om=117579&rd=1  

Summary 

The Display Network is your opportunity to reach potential customers that are browsing sites 
within Google's Display Network, rather than searching on a search term. Take the time to 
understand the various targeting options and then be creative! Not only can you use each 
method described in this chapter to reach customers in a new fashion, but you can combine 
various methods to refine your targeting. Targeting options include the following: 

▪ Remarketing: Visitors to pages within your site are cookied and shown your ads while browsing 
on the Display Network. 

▪ Contextual Targeting: Display sites are matched on the theme of your keywords. 

▪ Managed Placements: Display sites are selected individually. 

▪ Topics: Your ads are shown on sites that are matched to a topic or excluded from showing on 
sites related to particular topics. 

▪ Interest Categories: Ads are matched to visitors' browsing interests. The content of the site is 
irrelevant. 

▪ Display Campaign Optimizer: Display sites and bidding are automatically optimized. 

Because the Display Network doesn't reach an audience that is actively searching, it's important 
to position your bids and ad creative with this in mind. Image and video ads are useful for making 
your ads stand out. Use the data available in both the AdWords interface and Google Analytics to 
fine-tune your display campaigns. 

Advertising on the Display Network requires separate strategies and goals. Another rapidly 
expanding ad channel within AdWords that has its unique characteristics is mobile advertising. In 
the next chapter, we will explore this area of paid search and its unique opportunities. 

 

Creating Ads and Landing Pages 

Overview 

Selecting the best keywords for your campaign is only the first step. Getting users to click your 
ad and convert are the essential next steps. Finding the right message that attracts the attention 
of your audience is an important piece of a successful campaign, as is addressing your 
audience's questions and needs with well-crafted landing pages. 

The search intent of a user is generally categorized as navigational, informational, or 
transactional. We are primarily interested in the transactional category here, since advertisers 
are promoting products or services. The average amount of time the user spends looking at a 
search results page is different for each category. One study showed that searchers looked at a 
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search results page an average of 10.3 seconds, and that they viewed a single result an average 
of 1.3 seconds. This is not much time to convince a user to click your ad. 

In this chapter, we will discuss writing ads for the Search Network. Before we go into the strategy 
for writing compelling ad text, though, let's have a look at Google's editorial and legal 
frameworks. 

Writing Compelling Ad Text 

Now that you understand the landscape, it's time for the fun part: writing compelling ad text. 

Creating an effective message, given the constraints and guidelines covered in the previous section, 

is truly an art. Don't be concerned if it sounds like a daunting task. Although writing effective ad text 

isn't easy, practice and testing will constantly improve your ad writing skills. Depending on your 

goals and where searchers are in the buying cycle, there are several paths for developing your 

message. In this section, we will discuss how to develop some strategies and how to focus these 

strategies in a way that addresses your goals. 

As a general rule of thumb, be concise but thorough. Always keep your potential customer in 

mind when creating your ads: what is important to them and what will strike a chord with your 

audience? Well-crafted ads that resonate with your users will lead to higher click-through rates, and 

higher click-through rates will lead to better quality scores. The goal is to get clicks, but clicks from 

the users that are potential clients. Your ad text needs to attract the right clicks—those that will 

convert for you.  

Call to Action 

If your primary goal is to drive conversions, it's important to include a "call to action" in your ad, 

telling the users exactly what you want them to do. Some examples of call to action phrases include: 

Buy here 

Call today 

Get a quote 

Subscribe 

Download 

Obviously, the action you want them to take should be clear on your landing page. Think about 

incentive-based words that help the user to think ACTION, such as "guaranteed" and "save." Another 

way to encourage an action is to include expiration dates in ads. 

Features and Benefits 

Features describe your product or service. The range of features, of course, can be as varied as 

the products on the market. For example, the description of dog food could be "grain-free and 

organic." Benefits highlight the advantages of your product or service and help to separate your 

products from the competition. Searchers who are early in the buying process are more likely to be 

attracted by features, while benefits are more likely to appeal to searchers later in the sales process. 

Searchers in the ZMOT phase (Chapter 3) will be comparison-shopping and gathering information. 

Highlighting benefits is one way to show users that you have the solution to their problem. Keep 

your target audience in mind when selecting between features and benefits. Often a combination of 

both features and benefits works best. 

Discounts 
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Offers of discounts resonate well with searchers who are comparison-shopping in the ZMOT 

phase. Given the choice between two ads, one of which offers a discount, searchers are more likely 

to choose the ad with the discount. Think about what you can offer that the competition doesn't, 

such as free shipping or 24/7 support. Bargain-hunting words and phrases include: 

Coupon 

Price cut 

Rebate 

Markdown 

To comply with Google's rules, you must display the offer stated in the ad within one or two 

clicks of the landing page, and the prices mentioned in the ad must be accurate.  

Create a Sense of Urgency 

Expiration dates and limited time offers induce a sense of urgency. With such little time to grab 

the attention of potential customers, evoking urgency is one way to encourage them to take 

action—now! Here are some example phrases you could use: 

Limited time only! 

Save today only! 

Offer ends tonight! 

Informative Ads 

Users often search to find an answer to a question. Informative ads are a way to show searchers 

you have the answer to their question. Again, searchers comparison-shop while in the ZMOT phase 

of the sales cycle. This is a great opportunity to connect with potential customers while they're 

gathering information. What questions would a searcher have that your product or service answers? 

Figure 7-3 shows two examples. 

 
Figure 7-3: Two examples of informative ads  

Pose a Question 

Questions in ads are attention getters. Your ads will almost always appear while a user is 

conducting a search, so your ad should flow with the searcher's thought process. People search with 

a purpose in mind. Questions such as "Looking for K2 Skis?" fit in with a searcher's train of thought. 

You can also use questions to arouse interest, such as "Like Skiing Deep Powder?" 

http://viewer.books24x7.com/assetviewer.aspx?bookid=47025&chunkid=578799029&resumebookmarkid=850221d2-8e56-e611-94a7-005056862d7f


Testimonials 

Fitting a testimonial into 70 characters or less is often impossible, but a strong testimonial (if one 

can somehow be shoehorned in) is very alluring. Searchers in the ZMOT phase are likely looking for 

product reviews. Include phrases such as "Read Customer Reviews" to searchers in the ZMOT phase 

to let them know you can help them with their research and learning process, then include 

testimonials on your landing page. Searchers further along (in the FMOT phase of the buying cycle) 

will more likely be interested in reviews of your business and the reasons why they should buy from 

your site. By the time they reach the FMOT buying phase, searchers usually know what they want: in 

a sense, they're at the store shelf. Give them a reason to buy from you.  

Official-Looking Ads 

Where appropriate, include the ™ trademark symbol (unregistered) or the ® registered 

trademark symbol to build brand trust and give your ad an official look. In a competitive space 

where other competitors might be bidding on your brand, this will help separate you from the 

crowd. 

Reflect the Search Query 

Including your keywords in the ad is an important process, no matter how you define your goals. 

Remember, words from the user's search query will be bolded in the ad text. This helps to serve as a 

link between the user's search query and your ad. Because you have created well-themed ad groups, 

creating ad text matching the keyword group is much easier. This can also help improve your quality 

score, campaign performance, and relevance. 

Dynamic Keyword Insertion 

For larger ad groups, dynamic keyword insertion (DKI) allows you to insert the user's search 

query directly into your ad. You can use this feature for the headline, ad description, or display URL. 

Because character length constraints can prevent some search query phrases from fitting into the ad 

text, you can provide alternative text that will display if the search query doesn't fit. Figure 7-4 

shows how a DKI ad would be set up in AdWords. 

 
Figure 7-4: Ad created using dynamic keyword insertion  

The phrase "keyword tag" is used to represent the capitalization of the search query. In other 

words, how it's capitalized will determine how a user's search query is capitalized in the ad. Consider 

the following examples: 

{keyword: Smith Sunglasses on Sale}: The search query appears in lower case. Let's use the 

search query "showdown smith sunglasses" as an example. In this case, the search query would be 

dynamically inserted as "showdown smith sunglasses." 

{Keyword: Smith Sunglasses on Sale}: If the first word of the search query is capitalized, you have 

the same search query as above, but this time it's inserted into the ad as "Showdown smith 

sunglasses." 
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{KeyWord: Smith Sunglasses on Sale}: This time each word within the user's search query is 

capitalized, but this time the phrase would appear in the ad as "Showdown Smith Sunglasses." 

With phrase and broad-match keywords, the keyword inserted will match the keyword in your 

ad group that triggered your ad. Let's use the above example to help clarify this. You have the 

keyword "smith showdown sunglasses" in your account and a user searches for "find smith 

showdown." Google matches this query to the broad match keyword "smith showdown sunglasses" 

and that text is inserted into your ad.  

Be aware of the keywords in your ad group, and ask yourself whether they would make sense 

when inserted in your ad. We believe DKI should be used only sparingly; in well-designed campaigns, 

you often don't need it. However, keep this tool in your arsenal and try rotating in DKI text when 

testing various ads. 

The Display URL 

Think of the display URL as a fourth line of ad text. It actually is, so it's nearly as important as the 

first three. The display URL gives users a hint of where they will go when they click your ad. Although 

the display URL doesn't have to be a page on your site, the displayed domain (i.e., the first part of 

the URL up to the first slash) must match that of the destination URL. This leaves several options for 

including keywords and messaging within the display URL. The display URL can serve as a place to 

sneak in words that might otherwise be prohibited for trademark reasons. Take, for example, the 

URL www.buytvs.com/sony. Anywhere else in the ad, you wouldn't be able to use the word "Sony." 

Nevertheless, as part of the display URL, it's representing a page on your site and thus would be 

approved. 

Within a given Ad Group, the domain for all the display URLs must be the same, but destination 

URLs can vary. If you need to take the user to different sites, you should create separate ad groups 

or campaigns for each site. 

Remember, the click-through rate of the display URL is a factor in the quality score. Google 

treats this line of the ad separately from the rest in determining the quality score. 

The Destination URL 

Although not visible, the destination URL is an important component of the ad. Every click an ad 

receives will take the user to that destination (also known as your landing page). Each ad, or even 

each keyword, can have a different destination URL, as long as the domain remains the same 

throughout a given ad group. To enter varying destination URLs at the ad level, create the ad with a 

different destination URL. To alter the destination URL at the keyword level, enter the unique 

destination URL within the Keyword tab of the AdWords interface or via the AdWords Editor tool. 

Keyword destination URLs trump ad level URLs. 

The most common reason for adjusting the destination URL at the keyword level is to perform 

tracking. Advanced tracking techniques are outside the scope of this book, but linking your AdWords 

and Google Analytics account will provide the data needed to generate the data and reports 

discussed here. It's important to note that this tracking does take place within the destination URL 

and other analytics programs, and more advanced Google Analytics tracking would require adding 

additional variables to your destination URL. 

Ad Extensions 
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Ad extensions allow you to add one or more lines to a standard text ad. We've found that ads 

with extensions see higher click-through rates. Use extensions as a tool to garner more attention 

and clicks to your ad. Possible extensions include location extensions, call extensions, product 

extensions, sitelink extensions, and social extensions. Figure 7-5 shows an ad with sitelink 

extensions. 
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Figure 7-5: Sample ad with sitelinks  

Ad extensions are added via the Ad extensions tab (see Figure 7-6). The added information may 

or may not appear as part of your ads. Currently, Google displays ad extensions only when the ad is 

in one of the top or bottom ad positions above or below the organic results. Multiple types of ad 

extensions can be set up for an ad. 
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Figure 7-6: Accessing the Ad extensions tab  

To create an extension or see statistics for an extension, choose the extension type from the 

pull-down menu. Let's take a closer look at the various types of ad extensions. 

Location Extensions 

We discuss this feature in Chapter 5 when we focus on local advertising strategies, and we talk 

more about location extensions for mobile ads in Chapter 9. Any business can add a location 

extension, so this AdWords feature is a great way to increase your relevance to searchers. Location 

extensions can be added manually or by linking to your Google Places account. 

Call Extensions 

There are two types of call extensions. The first targets users on mobile devices with full Internet 

browsers. These users see your business number in the ad and can click to call your business. Users 

on desktops, laptops, and tablets will not see your number. We discuss this topic in Chapter 9 on 

mobile advertising. The second type of call extension uses a Google forwarding number. Google 

assigns a unique number to your ads via Google Voice technology. The ad displays this number on 

both mobile devices and desktops/tablets. If a user calls the number, the call is forwarded to your 

business number. Users on high-end mobile devices can still use the click to call feature. Google 

attributes the call data to the appropriate campaign, ad group, and keyword. 
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To enable a call extension, select the Call Extensions option from the Sitelinks Extensions pull-

down. Click "+New Extension" and you will see the screen shown in Figure 7-7.  
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Figure 7-7: Creating a Google forwarding number extension  

Google charges calls to a Google forwarding number a minimum of $1.00. In addition, you can 

set a bid-per-call, which requires setting a maximum call-per-phone call (CPP). 

Google shows call data on the Campaigns and Ad Group tabs by customizing the table to show 

call details. Alternatively, you can use the Segment menu to segment the data by click type. In 

addition, you can see detail data for your calls through the Dimensions tab. Go to View ➤ Select Call 

Details. When using a Google forwarding number, you can see the length of the call and the area 

code where the call originated. Use this data to determine the quality of leads coming from your 

calls. 
 
Note  Both call and location extensions allow you to enter a phone number. The number 

listed in a call extension will display regardless of the searcher's location, while location 

extensions are based on the location of the searcher and their proximity to your business. 

Call and location extensions can be used together. For example, a call extension could be 

used to display your main number and location extensions could be used to display a local 

number. 

Product Extensions 

When a searcher enters a query related to one of your products, products extensions allow you 

to display pictures and prices of your products below your ads through the expansion of a "plus box" 

(see Figure 7-8). Products extensions are a great way to give a boost to your ads. This is your chance 

to occupy more real estate and convey more information to your potential customers. Serious 

buyers can instantly see what you have to offer and at what price you are offering the displayed 

products. 
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Figure 7-8: Example ad with a product extension  

Product extensions are enabled by linking your Google Merchant Center with your AdWords 

account. To trigger a product extension, the user's search query must match the data in your 

Merchant Center. Product extensions only display on Google.com search results pages or on 

m.google.com on high-end mobile devices. 

To enable product extensions, you must first have a Google Merchant Center set up. In addition 

to providing the data for product extensions and product listing ads, Google Merchant Center 

provides a hub where your products can be uploaded for use in Google Product Search and Google 

Commerce Search. The setup process requires a Google account and a data feed for your products. 

To create a Merchant Center, go to www.google.com/merchants and start the process of configuring 

your account. For more information on creating a Merchant Center account, refer to the Merchant 

Center support at www.google.com/support/merchants/. The next step is to link your Merchant 

Center and your AdWords account. Sign into your Merchant Center and enter your AdWords 

customer ID by clicking AdWords in the Settings menu. 

Next, log back in to your AdWords account. Navigate to the Ad extensions tab. Click "Product 

Extensions" from the View pull-down menu. When you choose to "+ New extension," you will see 

the options shown in Figure 7-9. 

Larger View 

 

 

Figure 7-9: Adding product extensions  

The products that show up as extensions are determined by the information in your Merchant 

Center data feed. To further control which products are shown, you can use either product filters or 

auto targeting. Both allow you to better match products to your ads based on attributes within your 

Google Merchant Center data feed. You will need to make sure these attributes are populated 

within your feed and then uploaded into your Merchant Center. Once uploaded, product filters are 

configured through the product extensions tab. Click "Filter (advanced option)" (See Figure 7-9) 
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when creating your product extension. With previously created product extensions, product filters 

can be added by clicking on the Ad Extension within the table to enable editing. You can then define 

which products match a campaign based on product type, brand, condition, adwords labels, or 

adwords grouping. The "adwords_grouping" and the "adwords_label" attributes are specific to 

creating custom groups of products that you define. 

"Adwords_grouping" only accepts one value, while the "adwords_label" can have multiple 

values and thus can be used to associate a product with multiple campaigns or ad groups. 

Adwords_grouping can be used with CPA or CPC bidding, while AdWords_labels can only be used 

with CPC bidding. 

Once your Merchant Center is linked to your AdWords account, a new tab will appear for Auto 

targets. Click the Auto targets tab to match ad groups to an attribute. You have to set at least one 

target, which could be the "Add all products" option. Other target options are the same as with the 

product filters (Figure 7-10). 
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Figure 7-10: Setting Auto Targets for Product Extensions  

Once you have matched ad groups and attributes, the product targets will be displayed in the 

table as shown in Figure 7-11. To adjust bids for different product targets, click inline on the max CPC 

column. 
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Figure 7-11: Auto target data table  

Again, data on product extension clicks can be seen by segmenting by click type or by viewing 

the ad extensions tab. In addition, you can go to Dimensions ➤ Free clicks to see how many visitors 

clicked on the plus box. 

Sitelink Extensions 

This type of extension allows you to advertise more targeted or specialized pages within your 

site, as illustrated in Figure 7-12. 
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Figure 7-12: An ad with sitelinks  

Sitelinks give you full control over what links display, and they give you the opportunity to target 

multiple landing pages on your site. In addition, you can promote multiple areas where visitors can 

convert. By offering the searcher the ability to choose the landing page most relevant to them, 

they're more likely to convert. Sitelinks only appear in ads qualifying for the positions above or 

below the organic search results. High quality scores increase your chances of your ad displaying 

with sitelinks. 

Again, to enable this extension, go to Ad Extensions ➤ View ➤ Sitelink Extensions. Click "+New 

Extensions" and select your campaign (see Figure 7-13). 
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Figure 7-13: Enabling sitelinks  

Add your sitelinks by entering your link text and the corresponding destination URL. You can add 

up to ten sitelinks, although the number displayed won't exceed six. Click Save and your new sitelink 

combination will display in the table. Once you've created a sitelinks extension, you can easily add 

the same group of sitelinks to another campaign by clicking on "+New Extension," selecting the next 

campaign, and then click "Select extension." 
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Which sitelinks AdWords will display depends on the search query triggering the ad. Google uses 

the click-through rate of the sitelinks to determine the order in which they are displayed. 

Use sitelinks as an opportunity to combine the most successful elements of your campaign. Use 

ad text that has proven to have high click-through rates. Associate landing pages that are high 

converters, and promote sub-brands of your core brand. 

Another option for sitelinks is enhanced sitelinks. This newer sitelink format displays a headline 

with two description lines (See Figure 7-14). You can't define sitelink extensions within your account. 

Instead, Google looks at the sitelinks you have added to your account and matches the sitelink to a 

related ad in your account. 
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Figure 7-14: Example of Enhanced Sitelinks  

It's also important to note the following: although sitelinks add additional landing pages, landing 

page quality is still determined by the main destination URL. Google won't charge you if someone 

clicks more than one sitelink. Duplicate clicks are treated as invalid clicks. 

You may also add and edit sitelinks through the AdWords Editor. To access sitelinks, navigate to 

Extensions ➤ Sitelinks. Figure 7-15 shows the table where sitelinks are edited. 
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Figure 7-15: Adding sitelinks in AdWords Editor  

To see statistics for your sitelinks, return to the Ad extensions tab. Currently, performance 

statistics are only listed for the combined group of sitelinks, and individual link performance isn't 

available without more sophisticated tagging 

Social Extensions 

This extension allows you to show social recommendations as an annotation to your ads. To 

activate social extensions, you link your Google+ page with your AdWords account. +1s are shared 

between your AdWords ad and your Google+ page. Therefore, if your Google+ page has 25 +1s, 

these will show as an extension to your ad. If a user +1s your ad but doesn't click the ad, you are not 
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charged for a click. To evaluate performance of ads with the +1 annotations, you can segment your 

data by +1 annotations. We will talk more about segmentation in Chapter 10.  

Seller Extensions 

These automatically take effect when you reach certain levels relating to Google Product Search. 

There is nothing you can do to set up these extensions in AdWords. You must have 30 reviews in 

Google Product Search, and the reviews must be unique and rated at four stars or higher. A Google 

Merchant Account is not required. 
 
Note  The data shown within the Ad Extensions tab shows how many times an ad extension 

was shown and the clicks represent clicks to either the headline of the ad OR the 

extension. To see clicks for only your extensions, use the "Segment" menu to choose 

"Click type." 

Product Listing Ads 

Not to be confused with product extensions, Product Listing Ads (or PLAs) show the pricing, 

images, titles, and other product-related information available from your Merchant Center (Figure 7-

16). As with product extensions, you should first link your AdWords account to your Google 

Merchant account. It's possible to have both a PLA and a text ad displayed at the same time, which 

increases your visibility on the page. Much like text ads, PLA ads are ranked based on bid, historical 

performance, and relevancy. Because the data in your Merchant Center controls when and where 

your PLAs are displayed, it's important to keep the data in the Merchant Center current. As you can 

see from Figure 7-16, your ad may appear next to your competitor's ads. 
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Figure 7-16: Example of Product Listing Ads  

Once your Google Merchant Center and AdWords account are linked, you can create PLAs by 

creating a new campaign set to run on the Search Network. (PLAs are not shown on the Display 

Network.) Select the proper campaign settings for location, language, budget, etc. Under the 

Advanced Options ➤ Ad Extensions, click on the check box next to "Extend my ads with relevant 

product details from Google Merchant Center." Click "Save and Continue."  

You will then be prompted to create your first ad group. Think about the best way to organize 

your ad groups. You can organize them based on the various attribute options including product 

type, brand, condition, adwords_labels, and adwords_grouping, or any combination of these. Name 

your ad group appropriately and under "Create an ad," click the radio button next to "Product Listing 

Ad." You then have the option of entering a promotion. This is not a required step, but it's a good 

opportunity to help increase your click-through rate (and potentially your quality score) by 
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advertising a special offer or special shipping rate. Under the Auto targets section you can choose to 

include all products, if relevant. Otherwise, uncheck this box and select your specific auto targets via 

the Auto targets tab at a later time. You do not need to enter keywords as Google will use the data 

in your Merchant Center to match your products to search queries. Enter your bid amount and click 

"Save ad group." If you did not select "All products" in the campaign settings, you will automatically 

be taken to the Auto targets tab. As with product extensions, this is your chance to tell Google what 

products to match with this ad group. Because Google pulls the data from your Merchant Center to 

create your ads, you do not need to do anything to your ads. However, you can create new 

promotions from the Ads tab by selecting "+New ad" and then clicking "Product listing ad." 

Ad Preview Tool 

The Ad Preview and Diagnosis tool is a way to see what your ad looks like live on Google without 

accruing actual impressions. You can use the setting options shown in Figure 7-17 to define the 

geographic region where your ads will show. This is especially helpful when you want to see ads set 

to display outside your current location. Settings for this tool are located within the Google AdWords 

interface under the Reporting and Tools tab. Enter a search query you would like to explore and 

select the domain, language, location, and device to match your campaign. 

Larger View 

 

 

Figure 7-17: The Ad Preview and Diagnosis tool  

The tool will generate a preview search result showing the live SERP without increasing 

impression numbers. Figure 7-18 shows an example of the preview screen. 
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Figure 7-18: The preview generated from the Ad Preview tool  

If your ad doesn't appear, the tool will show the reason, as well as suggestions for what you can 

do to increase visibility (Figure 7-19). 
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Figure 7-19: Ad preview results  

Checking Your Ad Status 

When you save a new ad, it's automatically submitted for review and will receive a status of 

either "under review" or "eligible." Ads under review won't display until Google reviews them and 

they're found to be in compliance with the ad policies. Ads listed as eligible are approved to run only 

on Amazon.com SERP pages for users who have SafeSearch filtering turned off, but won't run on the 

Search Network or Display Network. Google will normally review your ad within 1-3 days, at which 

time your ad will receive one of the following statuses: 

Approved: You are ready to go on all networks. 

Approved (non-family), Approved (adult): Google has deemed your ads not appropriate for all 

audiences. Not all sites on the Google Network will accept your ads and users that have turned on 

SafeSearch filtering will not see your ads. SafeSearch filtering is set up in the user's Google 

preferences and tells Google not to show ads in this category. 

Approved (limited): In this case, your ad will not show in all areas or on all devices. This could be 

caused by a trademarked term approved to appear only in some regions, or by other content, such 

as gambling, not approved in some regions. 

Disapproved: Google believes your ad violates one of their advertising policies; ads won′t display 

until you resolve the issue.  

Site-suspended: In this case, the web site has been suspended. For your ads to show, you'll need 

to edit your site to meet Google's policies. 

To check the status of your ads, navigate to the level of the account you are interested in and 

click the Ads tab. This will show all ads for that level of the account in the main table. Each ad's 

status shows in the Status column. For disapproved ads, view the reason for disapproval by cursoring 

over the call-out icon. 

Another way to find disapproved ads, especially in large accounts, is to use the filtering 

functionality within AdWords. To filter for disapproved ads, again navigate to the level of the 

account for which you would like to discover disapproved ads. This could be at the campaign level, 

the ad group level, or the account level. Click Ads ➤ Filter ➤ Create filter, as shown in Figure 7-20, 

to get started. 
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Figure 7-20: Navigating to create filter  
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The filter tool will pop up in yellow. Use the pull-down to browse the filter options, selecting 

Approval Status. Click Disapproved (Figure 7-21) and click Apply. 
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Figure 7-21: Selecting the Disapproved filter  

The interface lists the disapproved ads in the table below the Filter panel. Again, to see the 

disapproval reason, click the call-out icon next to the ad. Edit the ad, addressing the reason for 

disapproval, and save the ad again. This will resubmit the ad to Google for review. 

Test, Then Test Some More 

No matter how great you think your ad is, the users will tell you what works and what doesn't by 

the way they interact (or don't) with your ad. Test results will often surprise you. The ad you were 

sure would be the winner many times isn't. The bottom line is that there's no magical formula for 

determining the best ad, other than user response. Always have at least two ads per ad group and 

keep the testing simple. Test a single variable for a few weeks, declare a winner, and move on to the 

next variable. For example, you might want to start with the headline. Run two ads with the same ad 

text and display URL but different headlines. Once you have your winning headline, create two new 

ads with the winning headline but alternative descriptions. Next, don't forget the display URL! Test 

ads using various extensions in the display URL, with and without the "www," or by adding a 

subdomain. Rinse and repeat. Keep the variables simple: it should always be clear which element 

generated the win. 

Creating a Landing Page 

So you've now painstakingly selected the perfect keywords and lured users in with your 
compelling ad text; this is your chance to convince your visitors to convert! You've done the hard 
part—you got them to your landing page. Now bring them home! One of the advantages of paid 
advertising is that you have control over where you take visitors and what you present to them. 

Relevance 

The most important quality of a good landing page is relevance. As discussed in the "Quality 
Score" section in Chapter 2, Google emphasizes the importance of relevance by making it a 
major factor in the quality score. It's also important to the searcher. You have only a few seconds 
to lure users in, so when they arrive at your site, make sure they feel welcome. Can they quickly 
tell whether your page is going to answer their question? Is the information on your landing page 
related to their search and the ad they clicked? If everything is well connected (i.e., relevant), 
they should feel they've found the right place and want to stay a little longer to look around. As 
we've emphasized before, a well-organized account should have tightly-themed ad groups: with 
focused groups of keywords, it's much easier to create focused, relevant landing pages. In 
addition, well-themed ad groups should direct to a single landing page. 
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Building Trust 

It's also vitally important to establish trust quickly. Your visitors will want to know they can easily 
get to the solution they need. Landing pages should provide what the ad promises, what the user 
expects to see, and—more importantly—what the user wants. A high quality site also helps to 
build trust with your visitors. Speak to the keywords in the ad so it's abundantly clear they're on 
the right page. Use a clear heading that includes keywords to emphasize this point. 

Other ways to build trust are through testimonials, especially from authority figures. As discussed 
with ad creation, during the ZMOT phase visitors are looking for reviews of products as they 
comparison shop. During FMOT, they're looking for reasons to buy from you.  

What is Your Message? 

The message you convey to your visitors is largely dependent on why they're searching and 
where they are in the buying process (Table 7-1). 

Table 7-1: The Sales Process and Landing Page Creation  

Open table as spreadsheet 

Sales 
Process 

Users Intent Sample 
Keywords 

Landing Page Pointers 

ZMOT Informational 
searches 

"best organic 
dog food" "what 
is a short sale" 

Answer their question. Provide the 
visitor with information. Gain trust. 

FMOT Transactional 
searches, 
navigational 
searches 

"Good Doggie 
canned dog 
food" 

Send the searcher directly to the 
appropriate product page. Don't risk 
losing the conversion by making the 
visitor sort through your site for the 
product they want. 

Be sure to answer the searcher's question on your landing page. For informational searches in 
the ZMOT phase, it's important to recognize what the searcher is looking for and make sure your 
page provides that information. Take, for example, the search "what is a short sale." Obviously, 
the searcher is looking for information. Although this search might not be as direct as "realtor in 
Glenwood Springs, Colorado," this searcher is potentially looking for options for buying real 
estate or trying to learn more about their options for selling real estate. If your page addresses 
their query with in-depth information, they're more likely to convert in some way, perhaps by 
signing up to follow your blog about the details of the short sale and foreclosure procedure. If 
they become a follower of your blog, you have more opportunity to relay information to them, and 
you increase the prospect of building enough trust for the user to engage in a future transaction. 

Now let's consider the searcher in the FMOT phase who is ready to purchase. For example, let's 
say you are a tea company selling tea online, and a searcher has just clicked on your site after 
searching for "buy premium green tea." In this case, you would want to take the visitor directly to 
your page for your green tea product. Offering a promotion can address their question, which is 
"why would I buy from you?" Make your policies, shipping rates, and return procedure very clear 
to the searcher. 

Think "Convert" 

Once you've addressed what the visitor is looking for, the next step is to get them to do what you 
want them to: convert! Don't leave visitors wondering what to do next. It's your job to make the 
call to action abundantly clear. It's often helpful to reduce the navigation—or at least de-
emphasize it—so visitors aren't confused or overwhelmed. Be selective in choosing what else 
you link to from your landing page. In addition, be conscious of the complexity of the path to 
conversion. Don't make your user jump through hoops or scroll around the page to complete a 
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conversion. You are probably the person most familiar with your landing page, so do your best to 
look at it through the eyes of a first-time visitor.  

Instant Preview 

Google introduced its instant preview feature in 2011, allowing users to see a preview of the 
landing page before they click an ad. As of this writing, the feature is available for ads in top 
positions on the SERP, but not side positions. The latest version of the instant preview feature 
only requires a searcher to mouse-over any section of the ad. Figure 7-22 shows the double-
arrow instant preview indicator to the right of the first top ad in the SERP for a search on "organic 
coffee," shown above the cursor arrow. A portion of the instant preview page is shown to the 
right of the cursor and indicator in the figure. 
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Figure 7-22: Instant preview indicator (above cursor) for a search on organic coffee  

Instant preview can increase click-through rates. This could be an advantage for PPC marketers, 
since PPC marketing allows you to handpick your landing pages and fill them with information 
targeted to the search. This is even more reason to include keywords and images in your landing 
pages. Be sure to use the instant preview feature on your own ads to see what you page looks 
like in the preview. 

Testing Landing Pages 

As with the other aspects of a campaign, it's important to use information generated through your 
visitors' actions to improve your results. Another very useful tool that Google provides for testing 
landing pages is the Google Website Optimizer (GWO). We discuss this tool more in Chapter 12. 
The GWO allows you to perform two kinds of tests: multivariant and what's called A/B or split 
testing. With A/B testing, only one element on the page is varied at a time. This element may be 
any part of the landing page critical to conversions. With multivariate testing, multiple elements 
within the conversion process are varied and are then combined to create multiple versions of 
the web site. 

For a simple comparison of destination URL performance, there is a destination URL report 
within the AdWords interface (Figure 7-23). To access this report, go to the Dimensions tab in the 
main Adwords account table and click Destination URL. Use the destination URL report to 
compare conversion rates for various landing pages. 
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Figure 7-23: Destination URL report  

For more in-depth information, there is also a destination URL report in Google Analytics (GA). 

To access this report in GA, bring up the profile you're interested in, click Advertising ➤ 

Destination URLs, as shown in Figure 7-24. 

 
Figure 7-24: Accessing the destination URL report in GA  

By default, the report will show the statistics illustrated in Figure 7-25. 
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Figure 7-25: Default statistics displayed in the GA destination URLs report  

These are useful statistics when ascertaining the success of a landing page, as well as for the 
purpose of comparison. Performance can be viewed at the Campaign, Ad Group, or Keyword 
level. You can select to add a secondary dimension, such as keywords, to show URL/keyword 
pairs. Figure 7-26 shows the comparison of two pages within the same ad group. In this 
example, the first landing page has a much higher conversion rate. 
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Figure 7-26: Destination URL report in Google Analytics 

 

Chapter 6: Keyword Strategy 

Overview 

Keywords are the linchpin of all PPC marketing. They are the starting point of the process 
connecting the user's interest and intent to your ad campaign. Everything hinges on the set of 
keywords you choose. If a keyword that could materially improve your campaign is not in your 
account, then your campaign won't be hitting on all cylinders. The keywords you choose for your 
campaign will determine the quantity and quality of your visitors. In this chapter, we will discuss 
how to find the right keywords at the right time for the right audience. 

Here are the topics we cover in this chapter: 
▪ Keyword basics 
▪ Using Google's Keyword Tool 
▪ Selecting keywords 
▪ Refining your keyword list 

 

Keyword Basics 

In Chapter 2, we discussed the ZMOT marketing model. Here we will take a closer look at how to 
find the right keywords for the various phases of the buying process. Understanding why your 
customers are searching is the first step. The second step is to understand how they are 
searching. The how starts with the keywords that you need to be marketing. By gaining visibility 
when consumers search for these keywords, you're able to gain interest and use this opportunity 
to convince them to use your products or services. It all comes down to mining for the right 
keywords.  

Note  
It isn't possible to start out with a perfect keyword list. An effective keyword list is the 

result of an ongoing process that will need to be constantly honed and refined. 

Let's take a closer look at some important concepts relating to keywords. 

The Long Tail vs. the Short Tail 

Generally speaking, the earlier in the sales process a customer is, the shorter and broader their 
search.Let's return to an example from Chapter 2, where you aligned the sales process with 
sample keywords.  

Looking at the keyword progression in Table 6-1, you'll notice that as the search/sales process 
unfolds, the keywords typically become longer, more complex, and more narrowly focused. In the 
search industry, these more complex phrases are called long-tail keywords. In contrast, the 
general phrases are often referred to as the head. Figure 6-1 shows the relationship between the 
relative search volume of keywords and specificity. 
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Figure 6-1: The relationship between the relative search volume of keywords and specificity  

Table 6-1: Increasing Keyword Complexity in the Sales Cycle  

Open table as spreadsheet 

Sales Process Sample Keywords 

Stimulus Dog 
Dog food  

ZMOT Best organic dog food 
Dog food reviews 
Crain free dog food  

FMOT Newmans Own canned dog food  

As this graph shows, highly specific, long-tail keywords make up the bulk of searches. Targeting 
popular and more general keywords is not only expensive (because of greater competition) but 
results in missing a lot of quality traffic. This is consistent with what you learned about the sales 
process earlier (Chapter 3). According to a 2008 guest post by Dustin Woodard on Bill Tancer's 
Hitwise blog, "if you had a monopoly over the top 1,000 search terms across all search engines 
(which is impossible), you'd still be missing out on 89.4% of all search traffic."[1]  

Users searching with long-tail keywords with the intent of purchasing a product or service are 
usually further along in their decision process. Less competition and higher conversion rates are 
a great mix for PPC marketing, and careful, precise research in setting up your keywords will 
help move your campaign in this direction.  

Types of Keywords 

In addition to the specificity that long-tail and short-tail conveys, there are several other ways to 
group keywords. 

▪ Branded vs. non-branded: This keyword grouping is pretty self-explanatory, but 
when thinking about search-generated traffic it's important to differentiate the two. 
Users searching with branded terms are much further along in the sales cycle, so 
these keywords tend to have a high conversion rate. Branded keywords should be 
separated into their own campaign or ad group. When analyzing results, it's 
important to make this distinction, as campaigns and accounts that are heavily 
brand-focused will naturally see better performance. We will discuss tactics for using 
Google Analytics to segment data based on branded or non-branded traffic in 
Chapter 11. 

There's an ongoing debate in the PPC world about whether you should spend money on branded 
keywords when you already have a high organic search ranking for these keywords. At first 
glance, you might think it's a waste of valuable PPC budget. If you're getting free clicks, why 
spend any amount on these keywords? We believe buying branded keywords is money well 
spent. In general, we have seen an overall decline in sales when branded keywords are turned 
off. We believe it's due to an increase in brand trust when searchers see multiple listings. Bidding 
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on broad matched brand names also helps to identify misspellings of the brand that you might 
not be ranking for organically. In addition, brand keywords tend to have great quality scores (and 
low cost-per-click), which is another plus for your account. 

▪ "Buying" keywords: This is another way to describe keywords in the FMOT phase 
of the sales cycle and identify users who are ready to buy. These keywords consist 
of what you're selling with prefixes such as buy, purchase, shop for, etc. Include 
these keywords when promoting products on e-commerce sites. 

▪ Local keywords: When a location is included in a search query, you can bucket these keywords 
as local keywords. For example, Portland Oregon sushi restaurant is a location keyword. We 
discussed location-based searches in Chapter 5. 

▪ Product keywords: Again, these keywords tend to come late in the buying process and are very 
specific. Canon PowerShot 100HS and Fisher-Price Kid-Tough Binoculars are examples of 
product keywords. Don't miss the low-hanging fruit; these kinds of specific product keywords can 
improve you campaign's performance. 

▪ Broad vs. specific: Broad keywords include variations of multiple root keywords, while specific 
keywords are multiple permutations of the same root word. For example, some people might 
search for camcorder and variations of that root word, while others might search for variations of 
video recorder. Leaving out either combination could exclude a large portion of your potential 
audience.  

Identifying Your Themes 

When composing your first list, it's okay to keep it small. Go for quality keywords and try not to 
get overwhelmed by the large number of possible keywords. The ideal keywords will reflect your 
business and the goals of your campaigns. 

We like to create what might be termed "theme buckets" that aggregate keywords according to a 
set of themes. These themes will ultimately coalesce into your ad groups. The following are 
some suggestions to keep in mind when identifying your themes: 

▪ What are the main products and/or services that you're offering? 
▪ What themes are present on your web site? 
▪ What are the natural divisions within your product lines? 
▪ Where, in terms of geographic areas, do you want to offer your products or services? 
▪ Who are your ideal customers and what are they looking for? 

Next, start a spreadsheet, giving each theme its own column. Figure 6-2 shows an example 
spreadsheet for a travel company that focuses on high-end, luxury trips. Use multiple columns to 
make copying root keywords easy. 
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Figure 6-2: Theming keywords via Excel  

From here, spend some more time building out each theme. Browse your competitor's sites for 
additional ideas. Perform searches using your keywords and explore what you see. Use the 
Google Search AutoComplete feature as a guide. Look for synonyms and variations for your 
keywords. Think like your customers, and think about their intent. If you come across keywords 
you feel are a good fit for your business or web site but don't fit into an existing theme, create a 
new column. Be sure to include various themes that cover the ways people could think about 
your core products. For example, if you own a furniture store, you would want to include 
keywords that include sofa and couch. 
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In the next section, we will talk about Google's Keyword Tool, which taps into its considerable 
database of keyword and search information. 

[1]Bill Tancer, "Guest Post – Sizing Up the Long Tail of Search," Nov. 6, 2008, 
http://weblogs.hitwise.com/bill-

tancer/2008/11/sizing_up_the_long_tail_of_sea.html 

Using Google's Keyword Tool 

Google's Keyword Tool provides useful information on search volume trends, estimated CPC, 
and relative competition. You can easily import the data directly into your AdWords account or 
via a spreadsheet. The keyword tool can also recommend keywords based on an analysis of 
your site. The web-based Keyword Tool can be invoked directly in your browser using the 
following URL: 

▪ https://adwords.google.com/select/KeywordToolExternal  

However, when you access the tool externally, some of the features discussed here are not 
available. Alternatively (and recommended), you can navigate to the tool from your AdWords 
Account. One way to do this is to click the Tools and Analysis tab and select Keyword Tool 
(Figure 6-3). 

 
Figure 6-3: Selecting the Keyword Tool in AdWords  

A second way of bringing up the tool in your AdWords account is to select "+ Add keywords" in 
the Keywords tab. This will show a prompt for adding the keyword. Click the Keyword Tool link 
on the right of the prompt, as shown in Figure 6-4. 
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Figure 6-4: The Keyword Tool link  

Once the tool launches, you'll see the screen shown in Figure 6-5. 
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Figure 6-5: The Keywords Tool  

Start your keyword research by entering words or phrases you've collected in your list. Start with 
broader keywords from one of your themes (ad groups) and click the Search button. The terms 
you enter will show at the top of the chart and the suggestions from Google based on the 
keywords you've entered will show below the chart. Before selecting keywords from this list of 
suggestions, let's look at a few options for narrowing down the amount of data. 

Filtering Data 

There are several approaches to narrowing (or filtering) the suggested keywords in a way that 
focuses the list on your specific needs. The following are several options for customizing the 
results: 

▪ Combine words or phrases with categories. For example, researching a keyword such as Aspen 
Homes could trigger keyword phrases such as Aspen funeral homes or Aspen nursing homes. 
However, if you selected the category Travel, the results wouldn't include these types of 
keywords. 

▪ Filter based on locations and languages. However, locations only go to the level of countries. 
Google's Keyword Tool does not provide geotargeted data. For example, you can't see search 
volume of a particular keyword for the Chicago metro area. 

▪ Include or exclude adult ideas.  
▪ Perform keyword research specifically with mobile devices in mind (see Chapter 9); this will help 

you understand the mobile searcher and the possible search volumes. 
▪ Select "Only show ideas closely related to my terms." With this option selected, all results will 

include the words or phrases you entered. 
▪ Filter results based on the filter options shown in Figure 6-6. 

For Competition statistics, you can choose low, medium, or high; for the other options, you can 
base your results on amounts greater or less than desired volumes. 

▪ Select the match types. This is an important one. By default, the results shown are based on 
broad match versions of keywords. You'll find this option on the left hand side of the tool. All 
match types checked will be included in the results. The Keyword Tool is often used to discover 
keywords for organic search campaigns as well. When researching keywords for this purpose, 
it's important to select the exact match option. Note that the Keyword Tool ignores the "+" Broad 
Match Modifier on listed keywords, but this could change. 

▪ Specify the words or phrase that must be included in each result. Again, this option is on the left 
of the screen. By entering terms in the "Include term" box, you can require results that contain 
these words or phrases. There are a few options for including terms in the results. Terms entered 
with no quotes will appear in each result but not necessarily in the same order. Terms entered 
with quotes will appear in the order entered. When terms are entered separately (one on each 
line), the results will include at least one of the terms, but not necessarily both in the same result. 
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▪ Specify words or phrase that must be included in each result. You can add keywords that you 
don't want included in the results by entering them in the "Exclude terms" box on the left of the 
screen. Another option for excluding terms in your results is to enter the word or phrase into the 
tool indicated with a "-"(minus sign) prefix. 

 
Figure 6-6: Filter options  

Sorting Results 

Once you've selected your filtering options, click the Search button; the tool will generate a table 
of results based on your criteria. The maximum number of results generated is 800 (in other 
words, a lot!).  

To help sort through this data, you can customize the results table by configuring what data is 
shown. Figure 6-7 shows the available options. To access these options, click the Columns pull-
down on the right side of the table, as shown in Figure 6-7. 

 
Figure 6-7: Selecting columns for the results table  

Here is a description of what each column provides: 
▪ Competition: Indicates the degree of competition for a keyword as high, medium, or low. If you 

cursor over an item in the Competition column, you should see a data annotation showing the 
actual two-digit competition metric (between 0 and 1.00) displayed. 
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▪ Global monthly searches: Shows the number of global (all countries) monthly queries for a 
search term averaged over the past 12 months. 

▪ Local monthly searches: Shows the approximate number of search terms matching the 
keyword, averaged over the past 12 months. The number is based on the countries and 
languages you've selected, as well as your keyword match type. This is only relevant at the 
country level and not to locations set to regions (states), cities, or smaller areas. If there's 
insufficient data to determine the number, this will be noted in the column. 

▪ Ad share: Theoretically, this shows the percentage of time your site is displayed for the exact 
match version of a keyword. In reality, this statistic can be confusing, and it doesn't always 
generate results. 

▪ Search share: Similar to ad share, this statistic should indicate the percentage of time your site 
shows on the first page of the organic search results and is specific to your targeted country. 
Again, this is based on the exact match version only and rarely does the keyword tool generate 
results.  

▪ Local search trends: Shows the relative monthly change in search volume. Each green bar 
represents a month, starting 12 months prior to the last full month of data (Figure 6-8). Each bar 
is relative to the keyword's overall performance for the prior twelve-month period. This chart 
won't show in the tool unless you're signed in to your AdWords account. It's specific to your 
selected country and language, as well as your selected match type. Again, if there's insufficient 
data, this will be noted in the column. 

For example, if it's Oct 2011 and you're looking at the chart in Figure 6-8, the first month on the 
right represents the relative search volume for September 2010. The local search trends feature 
is helpful for understanding seasonal variations. 

▪ Approximate CPC: Shows the approximate cost-per-click you might pay if you were to bid on 
the keyword, averaged over all ad positions. 

▪ Extracted from web page: If a keyword is relevant to your site, the page of the site deemed 
relevant will be listed. 

▪ Google Search Network: This shows the number of searches for a keyword on the Google 
Search Network, averaged over a 12-month period. This metric is based on your selected 
country and language, and on the exact match version of the keyword. 

 
Figure 6-8: Local search trend by month  

You can also adjust the data in the results table by using the sorting functionality, as shown in 
Figure 6-9. 
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Figure 6-9: Sorting keyword results  

By default, the results are sorted by relevance to the searched terms. However, you can also sort 
the results by any of the column headings by clicking on the heading. 

One of the great features of the keyword tool is the ability to save keyword results while 
searching on additional keywords. The "star" feature (Figure 6-10) allows you to save keywords 
before starting another search. This allows you to build your list without doing multiple 
downloads. 

 
Figure 6-10: Marking keyword selections with the "star" feature  

Starred keywords are added to a list stored for later use and are displayed at the bottom right of 
the tool in the minimized "Starred" window (Figure 6-11). Keywords remain in the starred list until 
you download them or close the tool. Opening the list and clicking Remove can individually 
remove starred keywords, or you can click Remove all. 
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Figure 6-11: A starred keyword list in the Google Keyword Tool  

To generate another round of results, you can start the process over or click the tab for "More 
like these" and generate results based on the keywords you've selected or starred. 

Before you start downloading data, make sure you've thought about what is important to you and 
whether you've used the proper filters. If you have a tight budget, it may be a good idea to filter 
for keywords that match your bid prices (Figure 6-12). 
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Figure 6-12: Filtering by approximate CPC  

Downloading and Importing Results 

There are several options for downloading and importing results. The first is importing your 
keywords directly into an ad group. To do this, the ad group must have been previously created 
in your account. Select the keywords you want to import and click the "Add keywords" button. 
Then select the campaign and ad group to which you would like to add the keywords. 

Another option is to export the data to a spreadsheet. Figure 6-13 shows the options for selecting 
the group of keywords you wish to download from the table. 
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Figure 6-13: Downloading starred keywords  

As represented in Figure 6-13, you can set the download options to include downloading all the 
keywords, the keywords selected by checking the checkbox in front of the keyword, the starred 
keywords, or a bulk download. One of the advantages of downloading is that all the data from the 
chart will export, and you can use the spreadsheet to review and manipulate data or import to the 
AdWords Editor Tool. (We cover this tool in a later section of this chapter.) The exported 
statistics will match the visible columns in the results table. 

Another useful feature is the "View as text" option (Figure 6-14). You can add keywords that 
have been selected or starred to a text list that can easily be cut and pasted into your original 
spreadsheet. The text list is a great option when you're ready to export keywords and don't have 
a need for downloading the statistics, such as when adding keywords to AdWords Editor or when 
compiling a list of negative keywords. 

 
Figure 6-14: Downloading keywords by viewing as text  

Estimating Search Traffic and Cost 

To understand the cost of clicks for your selected keywords, you can use the Estimate Search 
Volume function. These are only estimates, as Google can't predict your click-through rates and 
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quality score. However, estimates are better than nothing, since it's important to get a feel for 
what your costs will be and to ascertain whether your keywords are a good fit for your budget. 

You can view traffic estimates for any selected group of keywords. You'll be prompted to 
associate the keywords with an ad group. The pop-up window will display estimates for average 
CPC, estimated clicks, and total estimated cost, as shown in Figure 6-15.  
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Figure 6-15: Estimated search traffic data  

To see the estimated cost for an ad group, use the star function to note the keywords you want to 
add to your ad group. Use the "View as text" option to cut and paste the new list of keywords into 
the top of the tool. Click the Search button and your searched terms will display in the top portion 
of the results. Select all these keywords and click "Estimate search traffic." A pop-up will display 
your campaigns and ad groups, where you can select the matching ad group. The summary will 
display the estimated cost per day for your selected list of keywords for that ad group. If the 
estimate is beyond your budget, you may need to examine your list more closely. 

Analyzing Web Sites with the Google Keyword Tool 

The Google Keyword Tool will generate results based on the content of your web site(s), as 
shown in Figure 6-16. Enter the URL of a web site and Google will crawl that site to determine 
the associated keywords.  
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Figure 6-16: Entering a web site  
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You can use this functionality to investigate a competitor's site, high-ranking sites, etc., and the 
Keyword Tool will display the keywords Google extracts from these sites. This can also be used 
as a starting point when first creating a keyword list; enter a page of your site and let Google tell 
you what it thinks the page is about. 

Researching Negative Keywords 

When using the Keyword Tool to research keywords, don't forget about identifying negative 
keywords. As you progress through the research process, make note of the keywords that have 
multiple meanings, some of which may be outside the scope of your business. We often open a 
text file and add these keywords as we use the tool. 

 

Other Options for Keyword Research 

In addition to using a keyword tool such as the one provided by Google, here are a few other 
options. 

Competitive Research 

It's always a good idea to do comparative searches for your product. Start at a general level then 
get more specific. Who are the online players that pop out? Who is your competition? If you're in 
an extremely competitive space, it might make sense to invest in a keyword spy tool. There are 
many third party tools on the market to help with this research. Most will list the keywords your 
competitors are bidding on and will show examples of their ad text. 

Web Analytics 

If you use a web analytics tool such as Google Analytics, look for the keywords visitors have 

used to reach your site. To find this data, in Google Analytics navigate to Traffic Sources ➤ 

Sources ➤ Search ➤ Organic. 

To see the non-branded search queries visitors are using to get to your site organically, you can 
follow the previous steps and then use the advanced filter option to exclude keywords related to 
your brand. Alternatively, you can create branded and non-branded segments. We will discuss 
this in Chapter 11 when we explain how to use Google Analytics to improve your campaigns. If 
you're researching keywords for a branded campaign, reverse this approach by using the 
advanced filter to include branded keywords. Figure 6-17 shows a sample table of organic 
search queries.  
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Figure 6-17: Organic non-branded search queries in Google Analytics  

One of the advantages of using Google Analytics to discover keywords is that the keywords 
come with a wealth of data related to your site. If you're running e-commerce and/or attaching 
monetary values to your goals, you'll already have an understanding of what you should bid for a 
particular keyword. 
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Google Insights for Search 

The Google Insights for Search tool (www.google.com/insights/search/) generates data based on 
worldwide Google web searches. You can see search volume as well as trends over time, and 
you can compare interest in a search term by area. Results can be filtered based on the type of 
search (web, image, news, or product), location, timeframe, and category. Google has minimum 
volume thresholds for keywords to be included in the tool, so keywords that don't see significant 
volume won't be included. The example in Figure 6-18 shows results for the keyword Aspen real 
estate. (Note: there are three "Learn more" links shown in this figure (upper right and lower 
center). If you're unsure of what you're looking at, it's often helpful to click on these links.) 
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Figure 6-18: Google Insights for Search – interest over time for Aspen real estate keyword  

What you can see from the "Interest over time" graph is that searches for Aspen real estate peak 
in the months of July and January. This is helpful information when budgeting for a PPC 
campaign. 

The Insights for Search tool also provides geographic information on variations in regional 
interest, as shown in Figure 6-19.  
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Figure 6-19: Regional data report from Insights for Search  

This data is useful for determining which markets are showing the most interest in your products. 

You can pull up Insights for Search results directly from the Keyword Tool. Click on the pull-down 
to the right of the keyword and the menu in Figure 6-20 will appear. Click on the option for 
Google Insights for Search. 
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Figure 6-20: Invoking Insights for Search from the Keyword Tool  

Generate Permutations 

Another option for generating keywords is by creating a table based on your core keywords that 
allows you to create your own list of long-tail keywords. Add various prefixes and suffixes to your 
root keywords to generate a table similar to Table 6-2.  

Table 6-2: Possible Keyword Prefixes and Suffixes  

Open table as spreadsheet 

Prefix Prefix Root Root Suffix Suffix 

Discount Organic   Dog food online store 

Review Organic    
Dog 

food     

Review Dog   food     

Buy Healthy Dog food online   

You can also find free tools online that will generate the permutations for you. SEOBook offers a 
free tool that outputs the data for easy upload to AdWords Editor. When first starting a new 
account, you don't need thousands of permutations. Instead, include variations based on 
different root words. Once you discover which keywords convert best, expand on those 
keywords. 

Match Type Settings 

In Chapter 2, we explained the various match types and their reach. As you enter keywords into 
your account, the match types you use are very important. Take the keywords in Figure 6-21 as 
an example. 
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Figure 6-21: Search volume variations by match type  
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In this example, the amount of search volume for the broad match keyword is over six times that 
of the exact match keyword. When deciding to use broad match, be certain to include an 
extensive list of negative keywords. One option for adding negative keywords is using lists. By 
creating lists, you can add negatives in groups and then associate these lists with multiple 

campaigns. You can find these lists in the tree navigation under Adwords ➤ Campaigns Tab (left 

navigation frame) ➤ Shared library ➤ Campaign negative keywords. A list can be created 

directly from the Shared library menu or from the Keyword tab. 

Broad match modifier (BMM) keywords are a great way to split the difference between broad 
match keywords and the more restrictive phrase and exact match. BMM opens up your keyword 
list without completely opening the floodgates. We have seen substantial increases in click-
through rates with BMM. Figure 6-22 shows an example of how CTR can increase with the use 
of BMM. CTR is shown in the right column.  
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Figure 6-22: CTR improvements with broad match modified keywords 

Selecting Keywords 

There are a couple of considerations to keep in mind when composing a keyword list. Remember 
that it's nearly impossible to find the perfect keywords at the onset of your campaign: a good 
keyword list is built over time. It's important to revisit the keyword research tool frequently for new 
searches. Make sure the keywords you choose accurately reflect your business. When using 
tools such as Google's Keyword Tool, you may be shown a wide range of suggestions, so be 
sure to handpick your keywords. Adding keywords suggested by Google without careful 
consideration will only result in mismatched keywords and a less cost-efficient campaign. 

Don't repeat keywords in an account; if you do, you'll be in competition with yourself. You can 
include a keyword more than once if the campaign settings are designed so that keywords are 
not in competition with each other, such as in campaigns running in different geographical areas. 
To check your account for duplicate keywords, AdWords Editor has a solution. Within the 

AdWords Editor, go to Tools ➤ Find duplicate keywords. The window shown in Figure 6-23 will 

pop up. 
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Figure 6-23: Finding duplicate keyword in AdWords Editor  

Next, define your criteria. Strict word order is most relevant when trying to find duplicates in exact 
or phrase match. Any word order will find duplicates for broad match. 

Once the tool has run and you're ready to delete duplicates, select the duplicates that you would 
like to delete. Use the "Select duplicates by" menu (Figure 6-24) to help select the duplicates in 
bulk. 
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Figure 6-24: Options for selecting duplicates in Adwords Editor  

For example, you can select the keywords that have the lower quality score or the higher cost-
per-click within the duplicate sets. 

AdWords Editor has another feature that's helpful when selecting and organizing keywords and 
it's called Keyword Grouper. We often use this tool as an aid when we've inherited an 
unorganized account or when we have an unstructured list of keywords. Maybe your client 
handed off a list of keywords and you need to start somewhere. The tool works at the ad group 
level to sort keywords based on common terms. Therefore, imported keywords will be placed into 
a single ad group. Create an ad group to house these keywords. Ad groups are limited to 5,000 
keywords so if your list is exceptionally big (i.e., over 5,000 keywords), you'll have to create more 
than one ad group. Treat this as a dummy group and name it something simple like GROUPER. 

Launch the tool by going to Tools ➤ Keyword Grouper in the AdWords Editor. A window will 
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open and you'll be prompted to select your ad group. Select your ad group, click "Generate 
common terms," and then click Next. Google's ad group suggestions will be listed, showing the 
included keywords and suggested ad group name. There's also an option for ad creation from a 
template, but we recommend skipping this option. 

Here are a few guidelines for selecting keywords: 
▪ When selecting keywords, be sure to keep in mind the searcher's projected intent. 
▪ Keywords should match your goals and align with the settings in your campaign. 
▪ Use the estimator to get a feel for what your spend will look like. Alternatively, you can export 

keyword data to a spreadsheet and generate your own estimates. 
▪ Cover a wide range as opposed to a narrow focus. See what works best; you're looking for 

keywords that will help you grow your account.  
▪ Use negative keywords to control the reach of your keywords. Negatives are especially 

important in constraining the wider reach of broad match keywords. 

 

Refining Your Keyword List Over Time 

Every day 16% of the search queries Google sees are queries that Google has never seen 
before. This means a keyword list is always a moving target. 

Search Query Report 

Search query data is helpful for refining your keyword list and discovering additional negative 
keywords to add to your account. Search query data shows you the actual queries that Google 
matched to your keywords that were then clicked on by visitors. This data allows you to see 
where unproductive traffic is occurring and what versions of your keywords are drawing the most 
clicks and conversions. Broad matched keywords will create the widest search query variations, 
while exact match keywords will have no variation. 

For example, let's say you're a fly fishing guide offering trips in Alaska, and you see in the report 
that your ad showed when someone searched for fly fishing jobs in Alaska. You're a small 
operation not looking to hire, and you don't want to pay for a click for someone who is clearly not 
a potential client. You use this information to add the negative keywords -job and -jobs to your 
negative keyword list. On the flip side, the search query report can reveal high-volume, well-
converting variations of your broad match keywords. You might also discover high volume 
keywords that warrant their own ad group. 

Other things to look for are abbreviations you didn't think of when first doing your research, 
varied spacing between words, or domain names or URLs you've overlooked. In all of these 
scenarios, making changes will help to improve your click-through rate, which in turn improves 
your quality score. As you make decisions based on data from the search query report, pay 
attention to the number of impressions to ensure you're basing your choices on a large enough 
sample size. 

There are two places to find this data: the first is from the keyword section of the AdWords 
interface, and the second is in Google Analytics. To see the report in the AdWords account 
interface, navigate to the Keywords tab and select All from the "See search terms" tab, as shown 
in Figure 6-25. If you would like to see only matched queries for a subset of the keywords, select 
the keywords you're interested in and then click on "Selected."  
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Figure 6-25: Locating the Search Query Report in the AdWords interface  

Once you launch the report you will see a list of queries with performance statistics for each 
search term (Figure 6-26). 
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Figure 6-26: Query statistics  

In the first column, search term refers to the search query that triggered your ads. The match 
type (second column) tells you how search terms triggering your ads are related to the keywords 
in your account. 

▪ Broad match: The searched term is a variation of a keyword in your account. Let's use the data 
in Figure 6-26 as an example and look at the search term aspen luxury rentals. Google matched 
this search term to a keyword in your account; perhaps the keyword aspen rental is in your 
account. According to the match type rules, it's logical that Google would make this match. 
Looking at that search term, you have a few choices. You can add aspen luxury rentals to your 
current ad group. (We recommend broad matched modified or exact match or both.) You can 
deem luxury not relevant to your business and add it as a negative. Alternatively, you could 
create another ad group focusing on luxury-related keywords with luxury-focused ad text that 
takes the visitor to a landing page focusing on your luxury offerings. 

▪ Broad match (session-based): This is an interesting one—and a bit confusing. The search term 
is considered a variation of a keyword from your account but is based on previous searches the 
user has performed during the same search session. This is part of Google's effort to personalize 
search results. Because Google is matching your ad based on earlier searches, your ads could 
be showing even though the searcher has changed the intent of their search. Session-based 
broad match is often frustrating to advertisers because there's little they can do to limit these 
types of matches. The best you can do in this situation is to add these search terms as 
negatives; however, it's certainly not possible to add every possible negative keyword. 

▪ Phrase match: The search term contains a keyword in your account. As a reminder, keywords 
set to phrase match will match to queries that include your keyword in the exact spelling and 
order but may contain words before or after the keyword. Look for keywords that match as 
phrase match but would work better as exact match. Also look for possible negatives. For 
example, you may have the keyword Alaska fishing guide in your account, and the search term 
Alaska fishing guide school is receiving clicks. In this case, school is another logical negative. 

▪ Exact match: The search term exactly matches a keyword from your account keyword list. The 
keyword in your account can be a broad match or phrase match keyword that matches exactly as 
entered. 

To review, search queries matched to your ads should be added to your account and irrelevant 
searches should be added as negatives. In the example in Figure 6-26, aspen luxury rentals, 
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"aspen luxury rentals", and [aspen luxury rentals] should be added to your account. Conversely, 
because your business is not located in Piscataway, NJ, add the following negative keywords: -
[Piscataway, NJ] and -Jersey. This will keep your ad from appearing for similar searches in the 
future. When adding negatives from within the report, you can select the keyword that you would 
like to add as a negative then click on the box for "Add as negative keyword." The settings in 
Figure 6-27 will appear at the top of the search query report. 
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Figure 6-27: Adding negative keywords from the search query report  

By default, Google suggests adding the keyword as exact match. However, exact match is not 
always the best choice. Take, as an example, a campaign where you are advertising for jobs 
within the mountaineering field. Fishing will never be relevant to your business. We would 
recommend adding just the word fishing as a broad match. Adding the negative as Google 
suggests will only exclude a very limited number of searches. Also, note that you have the option 
to add the negative keyword at the ad group level, the campaign level, or to a previously created 
negative keyword list. 

As with other tables in the AdWords interface, it's possible to customize the columns to show the 
data most relevant to you. To do this, click the Columns pull-down and select "Customize 
Columns." 

Google Analytics Data 

To see search query data in Google Analytics, navigate to a keywords report. Keyword data is 

available under Traffic Sources reports as well as at Google Analytics ➤Advertising ➤ AdWords 

➤ Matched Search Query. You can add a second dimension to show the keyword as it's listed in 

your report. Figure 6-28 shows an example table of the data you'll see. 
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Figure 6-28: Visit data for keyword matches  

By viewing the data in Google Analytics, you can see more in-depth information, such as Bounce 
Rate, which is available only in Google Analytics. 

Keep in mind that the search query data only includes queries for ads that were both displayed 
and clicked on. Therefore, if you're receiving impressions for search terms matching your 
keywords but not being clicked on, these search terms won't appear in these reports. Search 
query reports are not available for keywords in the Display Network (although there's a similar 
report for placements, which we will discuss in Chapter 8.) 
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The Opportunities Tab in AdWords 

Another source of information when refining your list is through the Opportunities tab in 
AdWords. The Opportunities tab is located in the main navigation section. Within the 
Opportunities page navigation frame is an Ideas link, which lists Google's suggestions for your 
campaign, broken out by budget and keyword suggestions. Figure 6-29 shows an example of 
suggested keywords. 
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Figure 6-29: Keyword ideas via the Opportunities tab  

You can sort the list by campaign by using the tree navigation on the left. You can also adjust 
results by choosing one of the goals suggested by Google, as shown in Figure 6-29. Click the 
ideas within a campaign and a window will appear, as shown in Figure 6-30. 
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Figure 6-30: Reviewing keyword suggestions  

We recommend reviewing the keywords closely versus adding keywords through "select all." 
Some keywords will be good recommendations while others will be out of the scope of your 
business and/or campaign. The benefit to looking through this data is that Google has insight into 
new searches in the Search Network, which change daily. 

Keyword Opportunities in AdWords Editor 

In addition to viewing keyword opportunities within AdWords, AdWords Editor provides ideas for 

expanding your keyword list. Once in the AdWords Editor tool, go to Tools ➤ Keyword 

Opportunities. There are three choices.  
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▪ Keyword expansion: Much like the Keyword Tool within AdWords, you can enter a keyword to 
see possible keyword suggestions. Figure 6-31 shows an example. 

Included in the results are search volume and competition information. You can add keywords 
directly into your account from this screen (Figure 6-32). 

▪ Keyword multiplier: The keyword multiplier lists keywords to generate new keyword 
possibilities, which can then be added directly to your account. Figure 6-33 shows an example of 
the tool in use. Keyword possibilities with low search volume are not included in the results. The 
threshold of this setting can be changed in your AdWords Editor settings (Windows) or 
Preferences (Mac).  

▪ Search–based keywords: This tool generates possible new keywords based on your web site. 
The suggested keywords are based on queries seen by Google over the past year. Because 
these suggestions are based on your web site, the volume estimates will differ from those 
provided by the Keyword Tool. Figure 6-34 shows the steps for generating results. 
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Figure 6-31: Keyword expansion in AdWords Editor  

 
Figure 6-32: Adding keywords from AdWords Editor suggestions  
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Figure 6-33: Using the keyword multiplier in AdWords Editor  
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Figure 6-34: Generating keyword ideas in AdWords Editor  

 


